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Getting Started

Welcome to the official Apple Pro Training course for Final Cut Pro X.

This book is a comprehensive guide to editing with Final Cut Pro. It uses
exciting real-world footage from the USA Network series Fairly Legal, the
award-winning documentary Delicious Peace Grows in a Ugandan Coffee
Bean, exciting Zero to Hero racing footage from Pullin TV, and Matthew
Modine’s short film, I Think I Thought, all to demonstrate both the fea-
tures of the application and the practical techniques you'll use daily in

your editing projects.

For those who have edited on earlier versions of Final Cut Pro, or who
edit on other NLE (nonlinear editing) platforms, you may ask yourselves:
why make the jump to Final Cut Pro X? The answer lies not only in what
Final Cut Pro X has the power to do, but what it has eliminated: many of
the stumbling blocks that slow down the editing process. So let’s start by

taking a closer look at how that power will affect you as an editor.
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The Power of “X”

Final Cut Pro X is not an upgrade, but a completely new application integrating some of
the best of the latest OS X technologies. What this means for the editor is significantly bet-
ter performance, workflow improvements, and the ability to perform many tasks simulta-
neously. For example, gone from Final Cut Pro X is the wait time for rendering and ingest.
In the past, these activities halted the editing process. Now, rendering and importing, even
analyzing and fixing, go on in the background as you continue to edit.

Another powerful aspect of the Final Cut Pro X technology is the Magnetic Timeline,
which keeps audio and video locked in sync so it’s virtually impossible to separate the
two accidentally. The Resolution Independent Playback System allows you to handle

and smoothly play all formats, from standard definition to 5K resolutions, regardless of
the origin of media. Final Cut Pro X can automatically control the quality and color of
images during ingest, while at the same time performing audio cleanup tasks. And you
don’t have to wait to begin organizing your footage. Metadata-based Keyword and Smart
Collections begin during the import process, organizing files based on people and shot
detection. Keywords will help you organize and locate clips within Final Cut Pro X with
unprecedented speed, and unlimited undos and never having to save will provide a level of
protection you've never known.

Bundled together, the many new developments in Final Cut Pro X will make your work-
flow faster, smoother, and easier so that you can spend more time in the creative decision-
making process. And isn’t that what editing is really about? But before you begin to
explore the new interface or jump into the editing lessons in this book, let’s take a more
detailed look at what’s “under the hood” of Final Cut Pro X to get a better understanding
of this powerful and intuitive editing application.

The Technology of “X”

You may have heard some of the geeky buzzwords like 64-bit processing and memory
management, Grand Central Dispatch, and OpenCL. But what do those terms mean, and
how do these features matter in the day-to-day drama of video editors? Here’s a brief look
at these technologies, what they are, and why they make a difference when editing with
Final Cut Pro X.

The 64-Bit Question

In order to utilize and support the new 64-bit processing in computer technology, Final
Cut Pro X had to be completely re-engineered. You might be asking, “2-bits, 4-bits,
64-bits, a dollar. . . how many bits do I really need?” Typically, more bits means you can
crunch bigger numbers—and crunch them faster—with more memory at your service.
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Each central processing unit (CPU) is composed of different parts (registers, arithmetic
units, controllers) working together to carry out an application’s instructions. CPUs (and
their components) are built to handle a specific number of bits (8, 16, 32, 64, and so on),
like different cars’ transmissions have different numbers of gears. Just as the number of
gears in a transmission determines how fast a car can go, the bit depth—or number of bits
the processor can manage—determines the largest number the processor can handle per
clock cycle, and the maximum amount of memory that can be accessed.

Speed

The clock rate is how fast a CPU executes instructions. A 64-bit processor can move twice
as much data as a 32-bit processor at the same clock rate, significantly improving perfor-
mance. A 2 GHz processor can perform two billion instructions per second.

More Memory

A 32-bit processor is limited to using 4 GB of RAM, but a 64-bit processor can enable
applications to address a theoretical 16 billion gigabytes of memory, or 16 exabytes. The
more RAM you have, the faster your applications run because more data is kept in very
fast physical RAM instead of on slower hard drives.

All this means that Final Cut Pro X runs faster than previous versions, can handle video for-
mats from DV to 5K, can color correct video in an instant, can pitch correct audio on the fly
while scrubbing through it, and can handle larger than ever project and sequence sizes.

Core Strengths

The Intel central processing units that Apple currently uses in its desktop and laptop
computers are actually made up of multiple processor cores. It’s like a two-for-one deal
at your favorite store. In older, single-processor computers, each step of a task had to be
performed in sequential order. Consider a task like mailing a letter. You fold the letter,
place it in an envelope, address and stamp it, and then drop it in the mailbox. If you're
the only one working on the task, and there are hundreds of letters, it takes some time
to complete the task. With modern CPUs that have more cores (current Mac CPUs have
between two and six cores), the Mac does more things at the same time, improving over-
all performance. Looking at that same mailing task, think of it as having one person per
stage of the task. So a processor with four cores is like having three more people helping
you: one to fold the letter, one to place it in the envelope, one to address and stamp it,
and one to drop it in the mailbox. With more help tasks get done more quickly.

Following the Thread
One method applications use to take advantage of multiple processors or cores is through
multi-threading, a programming technique allowing processors to work on different parts
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of a program at the same time. Multiple threads make applications more responsive by
allowing them to perform different tasks at the same time, like a mail program being able
to send and receive email simultaneously. But threading is complex, and implementing it
is difficult to program.

Now Arriving at Grand Central Dispatch Workstation

Grand Central Dispatch (GCD) is the technology Apple has developed to help software
developers write programs that let the operating system divide up jobs and schedule them
to run on different processor cores as an alternative to application threads. GCD is the
system services OS X uses to manage tasks, breaking them up into chunks, assigning the
chunks to different processors or cores, and integrating the results. It’s a lot like juggling,
but instead of balls or bowling pins, OS X is juggling code, making sure the right piece
gets to the right place at the right time. Programs that support GCD are multi-processor
aware and can do more work faster when more cores are available to do the work.

Because Final Cut Pro X supports GCD and is multi-processor aware, functions like back-
ground rendering, analyzing and correcting video on ingest, editing while still importing
video, and instant color correction are not only possible but fast. Think of more cores as
more hamsters spinning those wheels inside your Mac to make it work faster.

Come In, It’s OpenCL

Today’s modern video cards sport powerful graphical processing units (GPUs) capable of
performing trillions of calculations per second. But unless you're running games or high-
end 3D software, much of that power languishes, unused. OpenCL (Open Computing
Language) is an open standard set of routines, developed in part by Apple, that allows
application developers to harness the power of those GPUs. With OpenCL support, Final
Cut Pro X can use the video card’s GPU as another processor to analyze or render video,
perform instant color correction, or stabilize shaky footage.

Finish with a Cup of Cocoa

The magic behind all these powerful modern new features of both OS X and Final Cut
Pro X is the Cocoa application development environment. Cocoa is a suite of object-
oriented software libraries, runtime systems, and integrated development environments
for creating software for both the OS X operating system and iOS. Originally released as
NextStep in the late 1980s, Cocoa is a powerful set of object-oriented tools for creating
almost any kind of software for the Mac and iOS devices that can take full advantage of
Mac or mobile device hardware.

Together, all these elements form the incredible Power of X.
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Downloading Final Cut Pro X

Final Cut Pro X is available from the Mac App Store. Since installation can begin immediately
after purchase, you should read Apple best practices (http://support.apple.com/kb/HT4722)
prior to installing to ensure the best performance. The exercises in this book are based on
Final Cut Pro version 10.0.7. If you have an earlier version, you should download this free
update or some exercises may not work as described.

The Course Methodology

This is, first and foremost, a hands-on course. Every exercise is designed to enable you to
do professional-quality editing in Final Cut Pro as quickly as possible. Each lesson builds
on previous lessons to guide you through the program’s functions and capabilities.

If you are new to Final Cut Pro, start at the beginning and progress through each lesson in
order. If you are familiar with an earlier version of Final Cut Pro, you can go directly to a
specific section and focus on that topic, because every lesson is self-contained.

NOTE » Due to individual preferences settings, your screen may not match all screen
shots exactly as they appear in the book.

Course Structure
The book is designed to guide you through the editing process as you learn Final Cut Pro.

You will begin by learning to import and organize media, create metadata in the form of
keywords and Smart Collections, edit clips into a project, and then refine your project by
trimming and adjusting edit points and clip location.

After working on several projects, youw'll complete them by mixing the audio and adding
transitions and titles. Finally, you'll add effects, color correct your project, and then pre-
pare it for delivery.

The lessons are grouped into the following categories:

Lessons 1-3: Preparing to Edit in Final Cut Pro X
Lessons 4—6: Crafting the Story

vV Vv VY

Lessons 7-9: Completing the Cut
» Lessons 10-12: Applying Effects and Finishing

In addition to the exercises, each lesson includes “Take 2” scenarios that present real-world
challenges for you to practice what you've learned before moving on to new material.

xvii
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At the end of every lesson, you will have an opportunity to hone your skills as you apply
your own creative touches to an “Editor’s Cut” project, which is designed to review every-
thing you learned in the lesson.

Using the DVD Book Files

The Apple Pro Training Series: Final Cut Pro X DVD (included with the book) contains
the project files you will use for each lesson, as well as media files that contain the video
and audio content you will need for each exercise. After you transfer the files to your hard
disk, each lesson will instruct you in the use of the project and media files.

NOTE » If you have purchased this volume as an eBook or your Mac lacks a DVD drive,
you will find the URL to download the files following the book’s index. If you purchased the
eBook, you will also find a “Where Are the Lesson Files?” page located at the end of the book.

Installing the Final Cut Pro X Lesson Files

On the DVD, you'll find a file named APTS FCP X.sparseimage. This is a special file that
operates like a virtual disk. You will use the contents of this virtual disk for the exercises
in the book. Exercise care while installing these files (as with anytime you are performing
media management functions) to ensure that the projects and media on the virtual disk
are available within Final Cut Pro.

1 Insert the Apple Pro Training Series: Final Cut Pro X DVD into your DVD drive.

Depending on which version of OS X you are using and the Finder’s preferences, you
may not see the DVD on your desktop. A quick look in a Finder window will display
any mounted volumes (such as hard disks or DVDs) available to you.

2 In the Dock, click the Finder icon.

3 In the Finder window that appears, select the APTS FCP X DVD listed in the sidebar
under Devices.

4 With the DVD selected, drag the APTS FCP X.sparseimage from the DVD to your
desktop to copy it.

Alternatively, you may drag the sparseimage to any locally connected hard disk such
as an external FireWire or Thunderbolt hard disk. Whichever destination you choose,
Final Cut Pro must have access to the sparseimage, and you must have Read and
Write privileges. The DVD contains about 4 GB of data.
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5 After the DVD is copied, eject it.

Before you begin a lesson in this book, you must mount the sparseimage to give Final
Cut Pro access to the project and media files for the lesson.

6 On your desktop (or other location to which you copied the file), double-click the
APTS FCP X.sparseimage file.

A virtual disk labeled APTS FCP X appears under Devices in the Finder window’s sidebar.

NOTE » Depending on which version of OS X you use and the Finder’s preferences,
you may not see the APTS FCP X disk on your desktop.

Each lesson will explain which files to open for that lesson’s exercises. You should not
disturb the contents of the Final Cut Events or Final Cut Projects folders on the APTS
FCP X virtual disk.

Connecting Media to Project Files

The DVD’s APTS FCP X virtual disk links the projects and media files within itself. If for
some reason project clips appear as offline media files, you can reconnect to the Events
that contain the media.

1 In the Project Library, select the project containing the offline clips.

2 In the Inspector, select the Properties tab. At the bottom of the Inspector, click the
Modify Event References button.

3 If the media is available, click the Event referenced on APTS FCP X in the dialog that
appears and then click OK.

The clips appear and play back. You may skip the remaining step.

4 If the application is unable to find the media, click OK and quit the application by
choosing Final Cut Pro > Quit Final Cut Pro. Proceed with the steps in the previous sec-
tion “Installing the Final Cut Pro X Lesson Files” to reinstall the projects and media files.

Using Final Cut Pro on a Portable

Some of the keystrokes identified in this book for desktop use work differently if you are
using a MacBook or Apple Wireless Keyboard. Specifically, you'll need to hold down the
Function key (fn) when using the Left and Right Arrow keys to access the Home and End
keys, respectively.

XiX
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About the Media

Four sets of media are used throughout this book. Together they represent different types
of projects and media formats. The exercises instruct you to edit the media in a particular
way, but you can use any part of this footage to practice editing methods. Techniques you
learn using one set of media in a lesson can be practiced with a different set of clips to
create a new project.

NOTE » Due to copyright restrictions, you cannot use this footage for any purpose
other than executing the exercises in this book.

The media, as it appears in the book, includes the following:

Delicious Peace Grows in a Ugandan Coffee Bean—An award-winning documentary narrated
by actor Ed O’Neill, produced by Ellen Friedland, and directed by Curt Fissel. This docu-
mentary film tells the uplifting and inspiring story of how a group of Christian, Jewish, and
Muslim Ugandan coffee farmers overcame historical and economic hurdles to build harmoni-
ous relationships and increase economic development. The footage was shot as HDV 1080i60.

Fairly Legal—This footage is from the USA Network television series that starred Sarah
Shahi as Kate Reed. In this episode, “Bridges,” which was directed by Peter Markle, veteran
actor Gerald McRaney guests stars as Judge Nicastro. Thanks to her innate understanding
of human nature, thorough legal knowledge, and wry sense of humor, Kate is a natural
when it comes to dispute resolution. Except, it seems, when it comes to conflicts in her per-
sonal life. This episode was shot using the RED MX camera at 1920 x 1080 and 23.98 fps.

Zero to Hero—This exciting racing footage was produced by Pullin Television, in partner-
ship with the National Hot Rod Association. The series, which was produced and directed by
Stephen Pullin, highlights different drag car racing stars and showcases their backgrounds,
their passions, and their commitment to racing. Broadcast on Fox Television as well as
distributed over the Internet, each episode was created using a variety of camera sources,
including Sony EX3, Panasonic P2, and GoPro for live events, interviews, and field produc-
tion, as well as additional footage from ESPN broadcasts that was mastered on DVC Pro.

I Think I Thought—Matthew Modine wrote, directed, and starred in this sardonically
humorous short film about Joe—a thinker in a world that no longer tolerates analytical
thinking. The film was co-produced and shot by Adam McClelland and edited by Terence
Ziegler. It was released in 2008 and is available to download from the iTunes Store. It was
shot on the Panasonic AG-HVX200 camera.
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System Requirements

Before using Apple Pro Training Series: Final Cut Pro X, you should have a working knowl-
edge of your Mac and the OS X operating system. Make sure that you know how to use
the mouse/trackpad and standard menus and commands and also how to open and close
files. If you need to review these techniques, see the printed or online documentation
included with your system.

For the basic system requirements for Final Cut Pro X, refer to the technical specifications
at www.apple.com/finalcutpro/specs/.

About the Apple Pro Training Series
Apple Pro Training Series: Final Cut Pro X is both a self-paced learning tool and the official
curriculum of the Apple Pro Training and Certification Program.

Developed by experts in the field and certified by Apple, the series is used by Apple
Authorized Training Centers worldwide and offers complete training in all Apple Pro
products. The lessons are designed to let you learn at your own pace. Each lesson con-
cludes with review questions and answers summarizing what you've learned, which you
can use to help prepare for the Apple Pro Certification Exam.

For a complete list of Apple Pro Training Series books, see the ad page at the back of this
book, or visit www.peachpit.com/apts.

Apple Pro Certification Programs

The Apple Pro Training and Certification Programs are designed to keep you at the forefront
of Apple digital media technology while giving you a competitive edge in today’s ever-changing
job market. Whether you're an editor, graphic designer, sound designer, special effects artist,
student, or teacher, these training tools are meant to help you expand your skills.

Upon completing the course material in this book, you can earn Apple certification.
Certification is offered in all Pro Applications, including Aperture, Final Cut Pro, Motion,
and Logic Pro. Certification gives you official recognition of your knowledge of Apple
professional applications while allowing you to market yourself to employers and clients
as a skilled user of Apple products.

Apple offers three levels of certification, Apple Certified Associate, Apple Certified Pro -
Level One, and Apple Certified Pro - Level Two. Certification exams do not require class
attendance. Students who prefer to learn on their own or who already have the necessary
skill set in the chosen application may take an exam for a fee.
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Apple Certified Associate status validates entry-level skills in a specific application. Unlike
an Apple Certified Pro exam, you can take Associate exams online from the comfort of your
own home or office. Apple Certified Associate status is appropriate for students, for some-
one who is preparing for a first job out of school or a college-level program, or for anyone
interested in validating entry-level credentials. Instructions on how to take the exam are
included later in this book. For details on what the exam covers, please visit training.
apple.com/certification/proapps.

An Apple Certified Pro is a user who has reached the highest skill level in the use and
operation of Apple Pro Applications as attested to by Apple. Students earn certification
by passing the online certification exam administered only at Apple Authorized Training
Centers (AATCs). Apple Certified Pro status is appropriate for industry professionals.

For those who prefer to learn in an instructor-led setting, training courses are taught by Apple
Certified Trainers at AATCs worldwide. The courses use the Apple Pro Training Series books as
their curriculum and balance concepts and lectures with hands-on labs and exercises. AATCs
are carefully selected to meet Apple’s highest standards in all areas, including facilities, instruc-
tors, course delivery, and infrastructure. The goal of the program is to offer Apple customers,
from beginners to the most seasoned professionals, the highest-quality training experience.

For more information, please see the page at the back of this book, or to find an Authorized
Training Center near you, visit training.apple.com.

Resources

Apple Pro Training Series: Final Cut Pro X is not intended as a comprehensive reference
manual, nor does it replace the documentation that comes with the application. For com-
prehensive information about program features, refer to these resources:

» Final Cut Pro Help: Accessed through the Final Cut Pro Help menu, the Reference
Guide contains a complete description of all features. You can also access the help at
http://help.apple.com/finalcutpro/.

» For alist of other resources, please visit the Apple website at
www.apple.com/finalcutpro/resources/.

» For details on the Apple Training and Certification programs, please visit
training.apple.com.


http://help.apple.com/finalcutpro/
www.apple.com/finalcutpro/resources/
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Lesson 4

Building the Rough Cut

Having imported your media and organized your Events, you are now
ready to move into one of the most exciting parts of the editing work-
flow: building and crafting your story. Why “building” and not “telling?”
Because a story needs a foundation, a primary thread—let’s call it a sto-

ryline—that will take you from beginning to end.

Once you craft the primary foundation or storyline, you can refine it

by rearranging some clips and trimming others. You may want to add
complementary B-roll visuals to create a secondary storyline, or enhance
the story by adding music or narration. This is the real work of an editor,
and represents the tasks you will encounter in this very important part

of the editing workflow, and in this section of this book.

Baﬂle Lines

In this lesson you'll build a rough cut using the source media from the

Events. To begin, you will create a new project, and mark clips you've
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116 Building the Rough Cut

placed in Keyword Collections. Then, you'll choose your Favorite clips and edit them into
the project to create a primary storyline. Remember, it’s a rough cut. It will require trimming,
adjusting, and finessing, but all of that will be done in due time.

Creating a New Project

Every story you tell using Final Cut Pro is contained within a project. Projects are created
and cataloged in the Project Library. Here you can neatly organize and store your projects
until you are ready to refine them or share them with the world.

In this exercise, you will create a new project in the Project Library for the Zero to Hero story.

1 If the Project Library is not in view, click the Project Library button in the lower-left
corner of the Timeline, or press Command-0 (zero).

Show the Project Library - 360

When the Project Library is active, you'll see your internal hard disk along with any
external drives connected to your computer. Any projects stored on a volume will
appear under that volume’s icon.

2 To reveal the projects on the APTS FCP X disk, click its disclosure triangle. To reveal
the contents of the Lesson Projects folder, click its disclosure triangle.

The Lesson Projects folder was copied from the DVD and contains project files that
you will use throughout the book. One folder has been created for each lesson.

| Project Library

v B APTS FCP X

v @ Lesson Projects
» I Lesson 1

M Lesson 2
M Lesson 3
M Lesson 4
» [ Lesson 5
» [ Lesson 6




Creating a New Project

You'll create a new project for this lesson inside the Lesson 4 folder using the Zero to
Hero Event on APTS FCP X.

In the Event Library, select the Zero to Hero Event under APTS FCP X. In the Project
Library, select the Lesson 4 folder, and click the New Project (+) button.

Create a new project

A project dialog appears asking you to name the new project and the default Event
that contains your source media.

Name: INew Project
Video Properties: Set based on first video clip

Default Event: | Zero to Hero

Use Custom Settings |

In the Name field, enter Zero to Hero. From the Default Event pop-up menu, choose
the first Zero to Hero Event listed.

NOTE » Two Zero to Hero Events are listed if you did not delete the Macintosh HD
Events created in Lesson 2. The first Zero to Hero listed is on APTS FCP X and the
second is the Event you created on Macintosh HD.

In the Default Event pop-up menu, Final Cut Pro will display Events stored in the
Final Cut Events folders present on any connected hard disk. The current option dis-
played in the menu simply reflects the Event that was most recently selected in your
Event Library. As you edit, however, you can use clips from multiple Events in your
project.

By using the default settings, you're allowing Final Cut Pro to create a project using
video formats that match the first clip you edit, and audio settings that follow the
default audio options.
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118 Building the Rough Cut

EII3» To customize a project’s audio and video properties, click the Use Custom
Settings button. For Video Properties, select Custom, and then choose the desired
Format, Resolution, and Rate from the pop-up menus that appear. Selecting Custom
for the Audio and Render Properties section allows you to select Stereo or Surround
sound, the audio sample rate, and the render file format.

5 Click OK.

When you create a new project, it automatically opens in the Timeline window.
Notice that the name of the new project is displayed in the upper left of the window.

Bl Zero to Hero

You still have a few more things to organize in the Project Library. For example, to
narrow your focus among the many folders, you can bring your Lesson 4 folder front
and center, and close the other folders.

6 To return to the Project Library, press Command-0 (zero). For the purposes of this
lesson, drag the Lesson 4 folder onto APTS FCP X to bring it to the top level of that
folder’s hierarchy. Then click the disclosure triangle for the Lesson Projects folder to
hide the other lesson folders.

Project Library
B APTSFCP X

M Lesson 4

Zero to Hero
00:00 - 23.98p
Feb 10, 2012

- @ Lasson Projects




Screening and Marking Clips

EI»» When you create projects, Final Cut Pro creates a Final Cut Projects folder in
your Movies folder if Macintosh HD is selected or at the root level of a selected, non-
system volume. You can exercise a media management best practice by not manipu-
lating the project or media files in the Finder.

You can have an unlimited number of Final Cut Pro projects, but you can work on
only one at a time. Next you’ll get started building the project you just created.

7 Open the Lesson 4 folder to reveal its contents. To open the Zero to Hero project,
double-click its icon. The project opens in the Timeline.

Screening and Marking Clips

If you organized your clips into Keyword Collections, or had Final Cut Pro do it for you
on import, you'll have a head start on your editing process. Rather than needing to search
through a large group of clips to find the content you want to use, you can select a col-
lection of clips in the Event Library and start editing. In this exercise, you will work with
Zero to Hero interview clips that were previously imported into a Keyword Collection
based on the original folder structure of the media files.

> About the Zero To Hero Media

“Zero To Hero” was produced by Pullin Television in partnership with The National
Hot Rod Association to create entertainment programming for the professional
race teams as well as the grassroots racing community. The series, which was pro-
duced and directed by Stephen Pullin, highlights several drag car racing champions
and showcases their backgrounds, their passions, and their commitment to racing.
Some of the drivers featured in the series are Tony Pedregon, a two-time Funny

Car World Champion with 43 career wins and a top speed of 311.49 MPH; Tony
Schumacher, a seven-time winner of the Top Fuel Dragster World Championships
with 67 career wins and a top speed of 327.03 MPH; Antron Brown, a top fuel drag-
ster driver with 27 career wins, and a top speed of 325.37 MPH; and John Force, a
fifteen-time Funny Car World Champion with 132 career wins, and a top speed of
316.23 MPH. The series was broadcast on Fox television and also distributed over
the Internet. Each episode was created using a variety of camera sources, including
Sony EX3, Panasonic P2, and GoPro for live events, interviews, and field produc-
tion, as well as additional media from ESPN broadcasts mastered on DVC Pro.
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120 Building the Rough Cut

Starting with a Keyword Collection is a good first step for narrowing the choice of clips.
But the real craft of editing is to narrow your media choice within a clip so you can edit
just that selection into your project.

You can do this several ways. In the previous lesson, you used start and end points to
define a range, and rated that range as a Favorite. (Final Cut Pro can easily display those
Favorites as a group.) But you can also identify a clip range using start and end points and
then edit that selection directly into the Timeline. In this exercise, you will view clips and
mark the desired ranges you want to edit. You will also adjust the Event Browser to maxi-
mize its use for previewing clips before editing.

1 In the Event Library, click the disclosure triangle next to the Zero to Hero Event, and
select the Interviews Keyword Collection. Click the Filmstrip View button.

v ® Zero to Hero
[d B-Rall

|"1'1 Interviews

The four people in this Keyword Collection are racers in the National Hot Rod
Association (NHRA). They were interviewed on location at their race events.

All Clips -

As you've seen, the Event Browser can display clips in several ways. The more familiar
you become with the Final Cut Pro editing process, the more you will gravitate to dif-
ferent setups for specific purposes.



Screening and Marking Clips 121

2 To optimize the Event Browser for screening and marking selections within these
clips, do the following:

P Click the Filter pop-up menu and choose All Clips.

P If text or icons are already in the search field, click the reset button (X) to clear
the field.

P In the Action pop-up menu, choose Group clips by > None, and Arrange clips by
Name > Ascending.

P To choose a single thumbnail representation, drag the Duration slider right to the
All position, or press Shift-Z.

P Click the Clip Appearance pop-up menu, and deselect Show Waveforms, and
make the thumbnails as large as possible.

P In the View menu, make sure Skimming, Audio Skimming, and Snapping are
chosen.

NOTE » How you view clips in the Event Browser is a personal preference. You can
modify your choices as you work through these lessons, but the display setup in step 2
will be reflected in the images in this lesson.

3 To select the first clip, Antron Brown, simply click it. Then move your pointer through
the clip to skim it.

All Clips

Antron Brown

Playhead Skimmer

With a single click, a yellow range selection outlines the entire clip. Notice that you
can skim anywhere in the clip, but the white playhead remains positioned at the loca-
tion where you clicked when you selected the clip.

4 Skim away from the white playhead, and press the Spacebar to play the clip.
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R As you play a clip, you may want to fast forward a clip or play it backward
slowly to find the beginning of a word or a specific moment. You can press the J-K-L
keys to play the clip backward and forward, slow and fast, and use key combinations
to move frame by frame.

When you play a clip by pressing the Spacebar or the L key, the clip starts playing
from the skimmer location, not the playhead location. This makes it very convenient
to skim and play, skim and play, as you seek out editing options. When you’re screen-
ing a clip for the first time, however, you’'ll typically want to play from the beginning
of the clip.

5 To move the playhead and the skimmer to the beginning of the clip, press Shift-I,
which moves both skimmer and playhead to the preceding start point. Then press
Spacebar to play the entire clip.

NOTE » When the clip finishes playing, you can press the Spacebar to play it again.

To edit a portion of this clip, you will change its selection range. Since Antron begins his
comment at the very beginning of the clip, “One day you could be a hero,” the current
start point is fine. Next you'll set an end point.

6 Play the Antron Brown clip from the beginning again and stop after you hear him say,
“... you didn’t qualify for a race” Press O to set an end point at that playhead loca-
tion. To play from the start to the end points, press the / (slash) key and watch your
selected clip range play in the Viewer.

If the end point isn't exactly what you want—perhaps you caught Antron in the mid-
dle of his next word—you can change your range selection by dragging the selection

edge, or by remarking the clip. To help you find a specific ending frame, you can also
use the J-K-L or Left and Right Arrow keys.

REI» When audio skimming is enabled, you can hear Antron’s audio frame by
frame as you skim across the clip. To enable audio skimming, press Shift-S.
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7 To move the playhead to the end point, press Shift-O. Press the Left or Right Arrow
key to fine-tune the location of your new edit point, frame by frame. Make sure the

<

frame is after Antron says, “..you didn’t qualify for a race,” but before he begins his

next statement. To set a new end point at the playhead location, press O.

EI» Don't worry if your start and end points aren’t perfect. Once the clip has been
edited into a project in the Timeline, you can later apply trimming techniques to fine-
tune the edit points.

With your clip range marked, you're ready to edit it. However, you have more clips to
screen. You can rate this marked range as a Favorite for fast retrieval. You will learn
more about editing in the next exercise.

R You can also press I or O as the clip plays to set a start or end point. Creating
edit points in real time is referred to as marking on-the-fly.

8 In the Antron Brown clip, rate this portion as a Favorite by clicking the Favorite button,

or pressing E.

The green Favorite line appears in the clip over the selected range. This is one way
you can always see or easily return to the portion of the clip you liked.

9 In the Event Browser, mark selections for the two following clips. After you mark one
clip, remember to save that range as a Favorite so you can return to that portion and
later edit it into your project.

John Force—“There’s nothing like....greatest feeling in the world” Then press F to
save that portion as a Favorite.

Tony Pedregon—“The breed of the drag racer...has no fear” Press F to save this por-
tion as a Favorite.
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10

11

12

R Although keywords applied within a clip may overlap, ratings may not. Marking
a new Favorite that overlaps a previously marked Favorite results in one big Favorite.

Rating selections as Favorites is a good workflow to preserve and prepare potential
sound bites for editing. But another approach is to simply mark one or more selec-
tions within a single clip. In Lesson 2, you saw that Final Cut Pro remembers multiple
selections while importing from an SD cards. It works similarly while screening and
marking a clip in the Event Browser. You'll begin by marking a single sound bite.

Play the Tony Schumacher clip. Use the I and O keys to mark a range around Tony
saying “Nobody wakes up and thinks...average my whole life” Do not press E

NOTE » Make sure you read through the next few steps before marking a second
selection. If you press the I or O key at this point, it would replace the previous selec-
tion you made, not add to it.

This is a great comment and one you will most likely want to use in the Zero to Hero
project. But you might find other comments in this clip that are equally useful. As
you continue to screen this clip, you can mark another comment without losing this
selected range.

Continue playing the Tony Schumacher clip, and listen for when Tony talks about
dreaming of the monster moment. Skim or position the playhead to just before Tony
says, “People dream for that massive...”

You've already marked one selection in this clip that you don’t want to lose. To add
this second sound bite as an additional selection, you must use two modifier keys
along with the I or O key.

To set an additional range, start in the already marked Tony Schumacher clip, and
press Shift-Command-1.



13

14

Screening and Marking Clips

Rl Another way to create an additional range selection is to Command-drag the
clip’s filmstrip or thumbnail.

The start of a second range appears. As expected, this new range automatically
extends to the end of the clip. Let’s find a more precise end point after Tony’s killer
statement.

Play or skim the clip and position the playhead after Tony says, “..big monster
moment.” Press Shift-Command-O.

Now you have two range selections within a single clip. Depending on the workflow
you choose, you can continue screening and marking other clips before editing either
selection. Let’s select a different clip and return to this one later.

In the Event Browser, select the Tony Pedregon clip, and then reselect the Tony
Schumacher clip by clicking in the middle of the clip between the two selections.
Notice that both selections are still present. Click inside the first selection.
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126 Building the Rough Cut

Clip selections are persistent. That is, they remain with the clip until you manually
remove one or more of them. You can highlight a single range selection by clicking
inside it, or select multiple ranges by using a modifier key.

15 Command-click inside the second range to add it to the selection. Command-click
the first range to exclude it from the selection. Then Command-click it to add it
again. With both range selections active, press F to make these selections Favorites.

Just as you can have multiple selections in a single clip, you can also create multiple
favorites at one time from highlighted or active selections.

Rl To remove a range selection, click inside it to select it, and then press
Option-X to clear it, or Option-click the range.

Appending Clips in the Timeline

A flexible feature of Final Cut Pro is the ability to mark many Favorites before editing, as
you did in the previous exercise. Or, you can mark one clip, edit it into the project, and
then you select and mark the next clip, edit it, and so on. Whichever approach you take,
you have several methods for editing a source clip into a project.

One option is to simply add or append the clip to the end of the storyline immediately
after the last clip you edited. When you're building a rough cut, as youre doing in this
lesson, adding or appending clips is often the simplest approach to creating your primary
storyline. Every project is based on a primary storyline. In this exercise, you will use the
append edit option to edit the Favorite portions of the racers’ clips you marked in the pre-
vious exercise. You'll also take a closer look at some of the Timeline functions.

1 To view just the Favorite selections of the racers, in the Event Browser click the Filters
pop-up, and choose Favorites, or press Control-F.

Although just four racers are featured, five clips are displayed. This is because you
marked two portions of the Tony Schumacher clip as a Favorite. Those two ranges
appear separately in this filtered Favorites view.



Appending Clips in the Timeline

For now, let’s add these clips to the project in the order they appear in the Event
Browser. Later you can rearrange them in the Timeline.

In the Event Browser, select the Antron Brown clip.

Because you are viewing only the Favorites, the portion of the clip you previously
rated as a Favorite is selected. To add this clip to your project, you will use the
append function.

In the toolbar, click the Append button.

The Antron Brown clip is edited into the dark gray area in the middle of the
Timeline. This is where you will build your primary storyline, which, like the sto-
ryline of a book, is the main plot of your project. It drives the story you are telling
with video and audio. For now, the append function simply adds the Antron Brown
clip as the first clip of this story. Now you are ready to add your second Favorite clip
to the Timeline.
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128 Building the Rough Cut

Antron Brown

R 1f you do not choose to use Favorites as part of your workflow, you can mark
a range selection within a clip, select that range, and click the Append button to edit
that portion of the clip into a project.

4 In the Event Browser, select the John Force clip. To review the Favorite portion, press

the / (slash) key.

% John Force

Now let’s switch to the Timeline to see where this clip will be edited. As you switch
from one window to the next, a few things will change in the interface. Let’s examine
those changes so you will always know which is the active window.

5 To select the Timeline, choose Window > Go to Timeline, or press Command-2.
To select the Event Browser, choose Window > Go to Event Browser, or press



Appending Clips in the Timeline

Command-1. Use these shortcuts to continue switching between the two windows
and notice the changes in the following areas of the interface:

P Viewer image and name

» Dashboard
P Event Browser and Timeline background color
P Selected range color
P Rating buttons
& &L
Rating buttons with Rating buttons with
Event Browser active Timeline active

When the Timeline window is active, the image of the project clip appears in the Viewer
along with the project name. The Timeline timecode is displayed in the Dashboard, and
the Rating buttons are dimmed. The recently selected clip, John Force, remains selected

in the Event Browser but the selection outline is now gray and not yellow.

Selected clip in inactive window

When the Event Browser window is active, the John Force clip selection outline
returns to yellow and appears in the Viewer along with the clip name. The Rating but-
tons in the toolbar are active. Also, in each case, the active window’s background is a
lighter gray than an inactive window.

Selected clip in active window

Before you edit the John Force clip, let’s take a closer look at how the append edit works.
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6 To switch to the Timeline, press Command-2, and then press the Home key to move
the playhead to the start of the clip. Play the clip from the beginning, but stop playback
after Antron says, “take the Wally home.” Leave the playhead in the middle of the clip.

NOTE » The Wally is the trophy awarded to winners of an NHRA national event. It’s
named after the late NHRA founder, Wally Parks.

The toolbar has three edit buttons: Connect, Insert, and Append. Clicking each but-
ton performs a different type of edit. When you used append earlier, the function
itself did not appear all that special; however, it really is significant. An append edit
places the clip at the end of the primary storyline no matter where the playhead is
positioned. (You will learn about the other edits later in this lesson.)

7 To edit the selected John Force clip to the Timeline, click the Append button in the
toolbar, and watch where Final Cut Pro places the clip in the Timeline.

Antron Brown John Force

Even though the Timeline playhead was in the middle of the Antron Brown clip, Final
Cut Pro appended the new clip to the end of the storyline. By using the append edit,
you can very quickly add clips to your primary storyline.

REIII» The Append function is further defined as adding source clips to the end of
the primary or selected storyline.

Let’s add the third clip using the append edit keyboard shortcut.

8 In the Event Browser, select the Tony Pedregon clip. To review it, press the / (slash)
key. To append the clip to your project, press E.

When you take the time to select a Favorite range in each of your clips, as you've
done with these interview clips, you can move the editing process along even faster by
appending more than one clip at the same time. In fact, Final Cut Pro can append any
number of selected clips, or marked selections, in one step.
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Appending Clips in the Timeline

NOTE » If you want to change the order of the clips in your project, you can easily
rearrange the clips in the Timeline. You will do this later in the lesson.

In the Event Browser, drag a selection rectangle around the two Tony Schumacher
clips to select them. To append these two clips to the storyline, press E.

Both clips are added to the end of the project in the order they appear in the Event
Browser. If you Command-click to select multiple clips, they are added in the order
that you clicked them.

EII3» You can edit multiple range selections from one or more clips in the same
way. Select the range selections you want to edit, and then click the Append button, or
press E. The selected ranges will be edited in the order they appear.

Tony Pedregon Tony Schumacher

AW S

>
w

To become more comfortable viewing your current project in the Timeline, let’s
change the Timeline view and look at some of the Timeline buttons.

To fit all the project clips in the Timeline, make the Timeline window active, and
press Shift-Z. To play the project, press Home and then press the Spacebar, or the L
key. Remember that pressing the Up and Down Arrow keys moves the playhead back-
ward or forward to the beginnings of clips.

Zooming your Timeline with the Shift-Z shortcut is like performing a “Zoom to fit”
command. It will either stretch or shrink your clip display so the entire Timeline win-
dow is filled with all the clips in the project.
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In the upper-right corner of the Timeline, you'll find three buttons that control how
you skim through clips, including one that allows you to snap to clips as you skim.

11 Move your pointer slowly over the edit point between the Antron Brown and John
Force clips. Notice that the skimmer snaps to that edit point. In the upper right of the
Timeline, click the Snapping button, or press N, and then move across the edit point
once again. Notice that there is no longer a pull toward the edit point.

Snapping - N

Snapping selected

With snapping enabled, the skimmer easily aligns or snaps to the edit point and,
when at the edit point, turns yellow as a visual cue.

N Jﬁ::e
John Force John Force

NOTE » The Snapping button also controls snapping in the Event Browser.

Both the Event Browser and the Timeline have a playhead and a skimmer. In the
Timeline, the playhead and skimmer produce two different yet overlapping results.

12 Skim through the clips in the Timeline and notice that you are skimming the audio as
well as the video. Then drag the playhead from the top of its stem through the clips.




Viewing and Arranging Clips in the Magnetic Timeline

Dragging the playhead through the project does not preview the audio as skimming a
clip does.

13 Click the second button, Audio Skimming, to deselect it. Skim through the clips in
the Timeline, and then skim through the clips in the Event Browser.

With audio skimming disabled, you no longer hear the clips as you skim through them.
Earlier in this lesson, you chose Skimming, Audio Skimming, and Snapping from the
View menu. These are the same options controlled by these Timeline buttons. Selecting
these options in the Timeline also affects how you view the clips in the Event Browser.

REII»» The third button allows you to solo, or isolate, a clip. You will learn the use of
this button in a later lesson.

At times during editing, you may want to edit using only the playhead. If you don’t
want the skimmer to follow your every move, you can deselect the Skimming button.

14 In the Timeline, deselect the first button, Skimming. When you try to skim through
the clips in the Timeline or the Event Browser, you can’t. In the Timeline, return the
buttons to their active state by selecting all but the third button.

NOTE » When both skimming and audio skimming are enabled, deselecting the
Skimming button will deselect audio skimming as well.

Viewing and Arranging Clips in the Magnetic Timeline
Once you've edited clips and viewed their placement relative to each other, you may
decide that you can improve your story by changing the clip order. With the Magnetic
Timeline, you can easily drag a clip to a different location and let Final Cut Pro automati-
cally create a space for the clip by shifting the other clips. In this exercise, you will change
the order of the clips to improve the racing story. You will also employ the Timeline Index
to see the list of clips in your project, and learn additional methods to change the way you
view clips in the Timeline. Let’s start by enlarging the clip thumbnails in the Timeline.
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1

In the lower-right corner of the Timeline, click the Clip Appearance button. Click
through the six buttons, and then click the fifth button from the left to create larger
thumbnails. Drag the Clip Height slider to a middle position.

Clip Appearance

Each time you click a button, the clips in the Timeline change appearance. Sometimes,
clip appearance is a personal choice. Depending on where you are in your editing
workflow, however, it may be helpful to choose a particular view of your clips. For this
exercise, you simply want to see the individual racers clearly, and you're less concerned
with audio waveforms.

Antron Brown John Force

Before you change the position of the clips in the graphical Timeline layout, let’s look
at how they appear in a list.

In the lower-left corner of the Timeline, next to the Project Library button, click the
Timeline Index button, or press Command-Shift-2.

e e————————————

Show or Hide the Timeline Index - {32

The Timeline Index pane appears to the left of the Timeline. Clips and tags (such
as keywords) in the current project are listed here in their order of appearance. The
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Timeline Index provides a textual way to navigate your project. A gray highlight bar
indicates the clip that is currently selected in the Timeline.

Bi Zero to Hero

Tags Roles 5 items

ntron Brown

3 At the top of the pane, click Clips, if it’s not already selected. Beneath the list of clips,
select All. Then select the Antron Brown clip at the top of the list.

BEi Zero to Hero

Tags Roles O items, 00:

The number to the right of each clip indicates the timecode location in the project
where the clip begins. Above the list of clips, you can read the number of items in the
project and the duration of the selected item(s).

4 In the Timeline, select the John Force clip. In the Timeline Index, notice that this clip
is also highlighted. In the Index, select the Tony Pedregon clip. In the Timeline, that
clip is selected.

R If opening the Timeline Index caused some of the clips to go out of view,
press Shift-Z again.

The Timeline Index is a great tool to help find clips and other items in your project.
Although this project is small, it still provides a good opportunity to see how the
Index works.
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5

In the Timeline, drag the playhead through multiple clips, and watch what happens
in the Index. In the Timeline, drag the playhead between the Antron Brown and John
Force clips.

Bi Zero to Hero

Tags Roles D items, 00:08;11 selected

tron Brown
John Force
= Tony Padregon

In the Index, the playhead appears horizontally and moves up and down through
the clips as you drag the playhead vertically through the Timeline. You can leave the
Timeline Index open as you rearrange the clips in the project.

NOTE » You will explore other ways to view the Timeline Index in later exercises.

In the Timeline, play the first Tony Schumacher clip in which he says, “Nobody wakes

23

up and thinks, ‘You know, gosh, I hope I'm just average my whole life’

This dynamic line could really kick off the project with a lot of energy. Let’s move it to
the beginning of the sequence of clips.

Rl To perform these steps, make sure that the default Select tool is chosen in the

tool list.

Drag the first Tony Schumacher clip left to the head of the project. Before you release
it, notice the blue insertion line where you will place the clip. When you see the
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remaining clips reposition themselves, release the pointer to place the clip at this loca-
tion. Then play the first few clips of the project.

Antron Brown

As promised, this clip gives the project a fiery start. In the Timeline Index, notice how
the clip appears at the top of the list. Now let’s bring Tony Pedregon into the second
clip position.

Bi Zero to Hero

Drag the Tony Pedregon clip to follow the first clip. When you see the blue insertion
line and the other clips scoot aside, release the pointer. Play the first two clips.

When you drag a clip in the Timeline, a numerical value appears, indicating the
length of time and in which direction you are repositioning the clip.

While the remaining clips could be reordered in a variety of ways, let’s leave them in the
order they appear: Antron Brown, John Force, and the second Tony Schumacher clip.

To close the Timeline Index, click the Timeline Index button, or press Command-Shift-2.

In the next exercise, you will insert some B-roll racing clips into this project. You may
want to create additional room in the Timeline for the new material.
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10 In the Timeline, press the Home key to position the playhead at the beginning of the

11

project. Then move the skimmer to the middle of the Timeline. Press Command--
(minus) a few times to zoom out and press Command-= (equals) several times to

zoom in to the clips.

The more you zoom in, the wider the clip and skimmer become and the more clip
thumbnails you can see. Only the visual representation of each clip changes, not the
clip length or duration. Also, the zooming occurs around the skimmer location as
long as skimming is enabled. When skimming is disabled, zooming occurs around the
playhead position.

You can also zoom in and out of the clips by dragging the Zoom control in the Timeline.
In the lower-right corner of the Timeline, drag the Zoom control to the left to zoom

out, and then to the right to zoom in on the clips. To prepare for the next edits, settle
on leaving about a third of the Timeline empty.

R 1f you are using a mouse with a scroll ball, you can scroll through project
clips by moving the scroll ball left or right. You can also swipe two fingers across a
Multi-Touch trackpad to scroll through a Timeline.

Inserting Clips into the Primary Storyline
You have added clips to the Timeline to build your rough cut. Like any rough cut, this one

is a work in progress. So far, you've laid a strong foundation by editing and then reorder-

ing the interview clips that give this project its face, personality, and energy. Now it’s time

to insert other shots that show or demonstrate more of the racers’ story and passion.

But rather than append these clips to the end of the project, you will use the insert edit to

place, or insert, them between existing clips in the primary storyline. When you insert a
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clip, a space for the new clip opens up in the storyline similar to the way the clips opened
up when you repositioned them using the Magnetic Timeline.

In this exercise, you will work with media from the B-Roll Keyword Collection. In Lesson 2,
Final Cut Pro used the existing media folder structure for that project to create a Keyword
Collection of clips that were already organized in a B-Roll folder. Let’s start by picking three
shots to mark and insert into this rough cut.

1 In the Event Library, select the B-Roll Keyword Collection. In the Event Browser, from
the Filter pop-up menu, choose All Clips. Take a moment to change the thumbnail
view so that all clips are visible in the Event Browser.

When you first select the B-Roll Keyword Collection, no clips appear in the Event
Browser because the Favorites filter is still active from the previous exercises. By
choosing All Clips, you can see all the B-Roll clips in this collection.

All Clips

ZERD [0 HERD

NOTE » You may wish to momentarily set the clip height to a smaller setting in order
to see all of the clip thumbnails. The Clip Height setting is available by clicking the
Clip Appearance button to the lower-right of the Event Browser.
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As you look at the clip thumbnails, you will see a few audio-only clips. You won't
be inserting audio clips at the moment, so let’s hide those audio clips by choosing a
media file type in the Filters window.

2 In the search field, click the Filter (magnifying glass) button to open the Filter window,
or press Command-F From the Add Rule pop-up menu, choose Media Type. Then, in
the Media Type rule entry, from the Type pop-up menu, choose Video With Audio.

NOTE » You can leave the Text entry selected because the Text field is empty and will
not impact the search.

Filter

Includes B d

& [ Media Type [I8 = v Video With Audi
| Video Only
Audio Only
Stills

[“New Smart Collection

Only those clips that have both video and audio now appear in the Event Browser. In
the search field, notice the filmstrip icon that indicates that a search is active based on

media type.

To help place your audience at the scene, let’s find some racing and crowd shots to
insert into this project.

3 Close the Filter window. In the Event Browser, skim the wall low angle clip. To select
the action portion of this clip, drag a selection from the head of the clip to the point
where both cars are out of frame, at about 1:28 in the clip. Use the Viewer as a guide.
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R If the entire clip is already selected, deselect it by clicking the selection, and
then choose Mark > Clear Selected Ranges, or press Option-X. You can also Option-
drag anywhere in the clip to create a new selection.

You could edit this selection immediately, but to preserve the range of this material
for later use, rate it as a Favorite.

To rate the selected clip range as a Favorite, click the Favorite button, or press F.

EI@» Remember you can press Shift-1 or Shift-O to move the playhead to the range
start or end points, finesse the range by pressing the Left or Right Arrow keys or J-K-L,
and reset the start or end points by pressing I or O.

Skim through the crowd ots clip. To select the latter part of this clip, press I to set the
start point when the red racing lights come on, just before the man with a camera
turns. Press F to rate this selection as a Favorite.

When you set a start point by itself, a selection automatically appears from the start
point to the end of the clip. Likewise, when you set a single end point, the selection

appears from the head of the clip to the end point.

NOTE » OTS stands for over the shoulder. It’s used to identify a shot that shows a
point-of-view perspective, as though you were looking over a viewer’s shoulder. In
this shot, you are seeing the race track from the crowd’s perspective.

141



142

Building the Rough Cut

Skim the crowd wide clip. Notice everyone in the crowd moves their heads together at
the same time. Mark a start point before the heads turn, and press F to rate the selec-
tion from here to the end as a Favorite.

To view the Favorites you just created, from the Filters pop-up menu, choose
Favorites.

Favorites

The three Favorite selections you just created appear. Now that they are marked,
it’s easy to insert them anywhere in the project. To set the stage for this project, let’s
insert them at the beginning. To do this, you must first specify the edit location.

Press Command-2 to switch to the Timeline, and press the Home key to move the play-
head to the beginning of the project. Make sure the skimmer is not in a different location.

NOTE » When you press the Home key, it moves both the skimmer and playhead to
the beginning of the project. If you skim away from the playhead location into other
clips, and make an insert edit, the edit will be performed at the skimmer location.

To review, an append edit automatically places a clip at the end of a storyline no mat-
ter where the playhead is located. For insert and connect edits, you must first position
the playhead or skimmer where you want to place the clip.

In the Event Browser, select the wall low angle clip. In the toolbar, click the Insert but-

ton. Then play the first few clips.




Take 2

In the Timeline, the wall low angle clip now appears before the Tony Schumacher clip.

10 In the Timeline, snap the playhead between the first two clips. In the Event Browser,
select the crowd ots clip, and click the Insert button, or press W.

After you perform any type of edit in the Timeline, the playhead repositions to the
end of the newly edited clip. If you want to insert a shot to follow the clip you just

edited, the playhead is already in position.

11 To insert the crowd ws clip as the third clip, select it in the Event Browser, and press
the insert edit keyboard shortcut, W.

Rl As with append editing, you can also insert edit a group of selected clips or
marked selections at one time.

Take 2

The producer of your project is old school and remembers the good old days of drag-and-
drop editing. She says she doesn’t trust an editing system where you can’t drag and drop.
Although you enjoy the ease of using keyboard shortcuts to make your edits, you know
it’s also possible to drag a clip from the Event Browser directly into the Timeline at the
desired edit point. You ease the producer’s worries and perform a drag-and-drop edit by
following these steps:

EI»» Make sure snapping is enabled for these steps.

» In the Timeline, zoom the project so you can see the last clip.
» In the Event Browser, from the Filter pop-up menu, choose All Clips.
» Select the smokey banner clip in its entirety.

» Drag the smokey banner clip into the Timeline and snap it to the end of the Tony
Schumacher clip. Look for the blue insertion line before releasing the pointer.
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smokey banner

NOTE » With drag-and-drop editing, you needn’t drag the playhead to where you're
focused, and click a button in the toolbar. You can simply rely on your eyes to target the
new location and manually drag the clip directly to where you want it in the storyline.

Changing Edited Clips

Once you've edited several clips into your primary storyline, you may be distracted by one
clip that’s too yellow or another clip that’s too loud. There are stages during the editing
workflow when you will correct all of the color problems or perfectly blend each audio
clip. But for now, you just want to view the project without cranking up the volume con-
trol or checking to see if youre wearing amber sunglasses.

As you learned in Lesson 2, you can access the Inspector window to view video or audio
information about your clip. In this exercise, you will use the Inspector to make a few
adjustments that will make viewing your project more pleasant. This is an important part
of building a rough cut. Although you aren’t making final changes, you are tweaking the
Timeline to determine whether or not the clips you've edited are effectively telling your
story. Let’s start by adjusting the Timeline view.

1 In the Timeline, click the Clip Appearance button and click the third thumbnail but-
ton. Then drag the Clip Height control to make the clips taller.

I :

Clip Ap
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With this clip appearance option chosen, the clip waveform appears beneath the video
thumbnails. This makes it easy to see which clips need an audio boost and which are
already raising the roof.

Anton Brown John Forca

R Since you will be skimming a few loud clips, you may want to disable audio
skimming by deselecting that button in the Timeline, or pressing Shift-S.

Skim to the first clip and press Command-= (equals) to zoom in to this area. Then
play the first three clips in the project and watch the waveforms as they play.

wall low angle crowd ots

—

Notice that the first clip’s audio waveform is shaded blue and falls safely beneath the

horizontal audio volume line. The waveforms of the second and third clips, however,
go above the volume line; those portions of the waveforms appear yellow and red. You
can easily lower the volume of these two clips in the Timeline.

RII3» [ the waveforms, yellow indicates audio levels approaching peak levels,
whereas red indicates peaked audio. You'll learn more about peaking in Lesson 8; but
for now, know that red is too loud.

In the Timeline, move your pointer into the crowd ots clip and position it over the
volume line. When it turns into a vertical resize pointer, notice the 0 dB info flag, and
then drag down until the waveform is at a similar level to the first clip.
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NOTE » The abbreviation dB means decibels, the unit of measurement for audio volume.

R If the skimmer gets in the way of adjusting the volume line, deselect the
Skimming button in the Timeline, or press S.

When you lower the volume of the crowd ots clip, the waveform no longer displays
yellow areas or red peaks. But notice that the top portion of this clip is flat. When the
audio was originally recorded at the racing location, the loudness of the race caused
the audio to clip.

4 In the crowd wide clip, drag the volume line down to match the first two clips. Play
these clips in the Timeline. To enable skimming again, press S.

NOTE » Remember, the dB number you see in the Level field represents a change of
volume up or down relative to the original sound level of this clip.

Now when you play these clips, you can get a better idea of whether their audio con-
tent will work in the project.

5 Skim to the fourth clip, Tony Schumacher, and play it. Then click above that clip to
move the playhead to this location. Notice that the background sounds of the shop
are too loud, and the video has a yellow tint. Leave the playhead over the clip so you

can see it in the Viewer.
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R As you work with a particular portion of a project, it’s always a good idea to

zoom in to that area so you can see it more clearly.

This type of show is often shot under extreme conditions where you have to grab a
few minutes with a racer whenever you can, no matter what’s going on around him.
You may not have time to color balance the camera or ask everyone to leave the shop
and reduce the background noise. Final Cut Pro can help in both situations. To get a
closer look at this clip’s properties, let’s open the Inspector.

In the toolbar, click the Inspector button, and then click the Video tab at the top of
the window. In the Color section, select the checkbox next to Balance, and notice how
the clip changes in the Viewer.

Video Audio Info

D Tony Schumacher

Effects

Colar

Balance: Not Analyzed

Match Color: ~ Choose...

Correction 1:

Transform
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By selecting Balance, Final Cut Pro automatically color balances this clip, pulling out

the yellow cast, and making it look much more pleasing.

One of the uses of the playhead is to park it to identify a location, like a bookmark,
and hold that place while you skim to look for other content. In this situation, it
would be nice to compare the Tony Schumacher clip you just color balanced with the
clip featuring Tony later in the project.

7  With the playhead parked over the first Tony Schumacher clip, skim down to the second
Tony Schumacher clip to compare the clips. Then skim back to the playhead location.

In the Inspector, you can also adjust the volume of the selected clip as well as mute
individual channels.

8 In the Inspector, click the Audio tab and look for the Channel Configuration section
towards the bottom of the Inspector. Make sure the Channel Configuration area displays
four mono channels. If it doesn't, click the disclosure triangle next to the clip’s name.
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Channel Configuration

I':_/l ¥ Tony Schumacher Four Mono

Tony Schumacher - al

Tony Schumacher - a2

8 Tony Schumacher - a3

Tony Schumacher - a4

This clip has four audio channels. For this shoot, a lavaliere microphone recorded two
channels of Tony’s interview, and another microphone recorded two channels of ambi-
ent sound from the shop. By deselecting each channel, you can identify which is which.

In the Timeline, play the first Tony Schumacher clip, and as it plays, deselect the third
and fourth mono audio channels in the Inspector window.

Channel Configuration

[=] ¥ Tony Schumacher Four Mono

|T_/| Tony Schumacher - al

|:l"1 Tony Schumacher - a2

NOTE » If your pointer is over an audio channel in the Inspector when you press the
spacebar, you will hear only that source channel play and not the Timeline clip.

The lower two channels contain the background ambient noise from the shop. By
deselecting these channels, you can hear Tony’s interview more clearly.

Now let’s adjust the clip volume in the Inspector.
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10 In the Timeline, click above the Tony Pedregon clip and look at the top of the
Inspector window to see the clip name change.

Video Audio Info

= Tony Pedregon

13

Effects

R You can also Option-click a project clip to simultaneously select the clip and
cue the playhead to that location.

The Inspector window displays the selected clip’s properties, whether that clip is from
the Timeline or the Event Browser.

11 Play this clip and deselect the third and fourth mono channels. Then select them again.

In this clip, deselecting and turning off these channels leaves the clip sounding a little
tinny. Leaving them turned on gives the clip a fuller sound, but also raises the overall
volume.

12 In the Inspector window, drag the Volume slider to the left until the clip waveform in
the Timeline no longer has yellow areas or red peaks. Then close the Inspector. Now
the clip plays at a lower volume.

Effects

Volume and Pan

Voluma:

K

Pan Mode: None v

Connecting Clips to the Primary Storyline

As you build your rough cut, you may find that adding audio—such as narration, music,
or sound effects—improves your storyline. For example, it might be nice to add music to
help build momentum in the Zero to Hero project. But which edit option do you choose?
You wouldn't append music to the end of the clips. And you wouldn't insert it between
clips. Instead, you use another edit option in the toolbar to connect the clip to the primary
storyline.
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A connected clip could be any clip that is attached to the primary storyline in the
Timeline. Connected clips remain attached where you edit them until you move or
remove them. In this exercise, you will filter the Zero to Hero B-roll clips so that only the
audio clips appear, and then connect a music clip to your video sequence and adjust its
position in the primary storyline.

EII3)> [f necessary, press Shift-Z to view all the clips in the Timeline.

1 In the Event Browser, from the Filter pop-up menu, choose All. Press Command-F
to open the Filter window. From the Media Type pop-up menu, choose Audio Only.
Close the Filter window.

Filter

I T Text

& Media Type | v Video With Audio
Video Only
Audio Only
stills

R

REIII» You could also open the Filter window by clicking the search field when a
search rule, such as the media type icon, is present.

You now see just the audio clips that are part of the B-Roll Keyword Collection. Since
audio clips have no thumbnails, let’s view them as a list.

All Clips
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2

In the Event Browser, click the List View button. Then play the first part of the
Battle Lines music clip. Viewing this clip in list view provides an expanded view of
the waveform.

All Clips -

Battle Lines

Start End Duration
Auto Crash Concrete 00:00:00:00 00:00:03:13 00:00:03:13

Auto Skid 1 00:00:00:00 00:00:04:27 00:00:04:27
Battle Lines 00:00:00:00 00:01:50:38 00:01:50:38
Discipline 00:00:00:00 00:01:20:46 00:01:20:46
Explosion 6 00:00:00:00 00:00:04:36 00:00:04:36
great race 00:00:00:00 00:00:14:48 00:00:14:48
race crowd sfx 00:00:00:00 00:00:20:17 00:00:20:17

To edit the first half of this clip, mark a start point just before the music begins, and
an end point after the first series of waveform peaks.

REI»» With audio skimming selected, you can press the Left and Right Arrow keys
to find the exact music start.

In the clip waveform display, notice that some of the upper parts of the waveform
appear yellow and some appear red, indicating that the audio may be peaking at 0 dB.
As you know from the previous exercise, you can easily adjust the volume of this clip
in the Timeline.

All Clips

(AT TR N T |

You could start this music at the head of the project. But it might be more fun to let
the two race cars zoom by and then begin the music.
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4 To make the Timeline window active, press Command-2. Press the Up or Down
Arrow key to move the playhead to the beginning of the crowd ots clip.

As with the insert edit, when you edit a connecting clip, Final Cut Pro always places
the clip at the skimmer or playhead location.

5 In the toolbar, click the Connect button, or press the connect edit keyboard shortcut,
Q. In the Timeline, play the first few clips, and then look at the thin vertical line con-
necting the Battle Lines music to the crowd ots clip.

By performing a connect edit, you connected the music to the primary storyline at

the playhead location. Let’s see what happens when you reposition this clip.

Battle Lines

6 Drag the crowd ots clip to the right and reposition it after the crowd wide clip. Play
this arrangement, and then drag the clip back to its original position.

When you move the crowd ots clip, the music travels along because it is connected to
the clip youre dragging.

Battle Lines
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But just because you started a connection with one clip doesn’t mean you have to keep
that connection. By dragging the music later in the Timeline, you can connect it to a
different clip.

7 Drag the Battle Lines clip to the right and snap it to the head of the first Tony
Schumacher clip. Notice that when you snap it to this edit point the playhead turns
thick and yellow.

+09;13.00 |
Battle Lines

I

As you drag this connected clip, the thin vertical connection line relinks with another
clip in the Timeline, in this case, the Tony Schumacher clip.

8 Play the first few clips of the project.

Now the music provides a very dynamic start to the interview clips. However, you are
not limited to snapping a connected clip to an edit point. You can also shift the posi-
tion of the clip left or right. You can do this by using shortcut keys to shift the clip
one frame at a time, 10 frames at a time, or by entering a numerical length of time.

9  With the Battle Lines clip selected, press the , (comma) key several times to move the
clip to the left in one-frame increments. Then press the . (period) key to move the clip
to the right in one-frame increments. Press Shift-, (comma) to move the clip to the
left 10 frames, or press Shift-. (period) to move it to the right 10 frames.

EII3» The comma key shares the Left Angle Bracket key, and the period key shares
the Right Angle Bracket key. It may be helpful to think of moving in the direction
these keys point.
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Sometimes you can successfully finesse clip placement by adjusting it just a few
frames. Other times, you may need to move it a specific amount of time, perhaps to
allow for another clip you know will be edited later.

10 With the Battle Lines clip still selected, enter -200. Look at the Dashboard and notice
that the number entry has replaced the timecode location. Press Return or Enter.

When you precede a number amount with a + (plus) or - (minus) sign, Final Cut Pro
reads that number as a trim or nudge amount, even adding colons every two digits,
and moving the selected clip by that amount.

Editor’s Cut

You're now familiar with three types of edits, how to mark clips for editing, and how to
customize the Timeline and Event Browser. With this arsenal of knowledge, you can create
another rough cut using totally different media. Remember, you are still in the rough cut
stage of the editing process.

» To work with new media, in the Project Library, create a new project and name it I Think.

» In the Event Library, view the I Think clips and edit them in whatever sequence feels
natural for you.

» You can connect narration and music clips after you have the video clips in place.

NOTE » Although Final Cut Pro editing functions work the same regardless of the
media in use, rehearsing them using different types of media is a good way to hone
your editing chops and gain greater control over the tools, functions, and shortcuts.
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Closing Your Project
Once you finish working in a project, you may want to close it so that you have a clean

slate the next time you open Final Cut Pro.

In the Project Library, click the disclosure triangle next to the Lesson 4 folder to hide
its contents.

Drag the Lesson 4 folder into the Lesson Projects folder beneath the APTS FCP X icon.

R Closing a project in this way is a good practice to continue when finishing
each lesson.

Lesson Review

¥ ® Nk w D

—
(=]

11.

12.

What methods can you use to create a new project?

How do you create an additional range selection in the same clip?
What four different methods allow you to edit clips into your project?
What is an append edit?

How can you zoom in or out of an area of the Timeline?

How do you change the display size of the clips in the Timeline?

How can you view a list of all clips in the Timeline?

How can you quickly adjust a clip’s volume in the Timeline?

How can you mute specific audio channels for a clip in the Timeline?

. How can you toggle snapping on or off?

When you drag clips to rearrange their positions in the Timeline, what visual indica-
tor shows where the clip will be positioned when you release the pointer?

How would you connect music or B-roll to the primary storyline in your Timeline?

Answers

1.

Click the New Project (+) button; Control-click a folder or drive and choose New
Project from the shortcut menu; or select the target location, and choose File > New
Project, or press Command-N.



10.
11.
12.

Lesson Review

Set a range start and end for one section of the clip, then press Shift-Command-I to
start a new range, and Shift-Command-O to set the end of the new range. Another
method is to press the Command key and drag a range within a clip’s thumbnail or
filmstrip.

To create an edit, click an edit button in the toolbar; choose an editing command
from the Edit menu, such as Append; press a keyboard shortcut; drag a clip from the
Event Browser, from a media browser such as the Photos Browser, or from the Finder.

An append edit adds one or more clips to the end of a project or selected storyline.

Press Command-= (equals) to zoom in, and press Command-- (minus) to zoom out.
You can also zoom in and out by dragging the Zoom control in the lower right of the
Timeline.

Click the Clip Appearance button in the lower-right corner of the Timeline. In the
Clip Appearance window, drag the Clip Height slider to the left to decrease the clip
height, or to the right to increase the clip height.

In the lower-left corner of the Timeline, click the Timeline Index button, or press
Command-Shift-2. The Timeline Index pane appears to the left of the Timeline and
displays clips, roles, and tags (such as keywords) used in the current project in their
order of appearance.

Position your pointer over the volume line in the Timeline. When the pointer turns
into a vertical resize pointer, drag down to lower the volume or drag up to raise it.
Audio that approaches peak levels appears yellow in the waveform; audio that exceeds
peak levels appears red.

Select the clip in the Timeline, click the Inspector button in the toolbar, and then click
the Audio tab and deselect the appropriate channels.

Click the Snapping button in the Timeline, press N, or choose View > Snapping.
A blue insertion line indicates where clips will be placed.

Position the playhead in the Timeline where you want to connect one or more clips.
Select the clips in the Event Browser. In the toolbar, click the Connect button, or press
Q. In the Timeline, a blue connection line for video or a green connection line for
audio indicates the connection point.
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Keyboard Shortcuts

N

Command-N
Control-click
Command-F

, (comma)

. (period)

Shift-, (comma)
Shift-. (period)
Command-0 (zero)
Command-1
Command-2
Command-Shift-2
Command-- (minus)
Command-= (equals)

Shift-I

Shift-O

Shift-Z

Shift-S

Up Arrow

Turn snapping off and on

Create a new project

Open a shortcut menu

Open the Filter window

Move selection to the left 1 frame

Move selection to the right 1 frame

Move selection to the left 10 frames

Move selection to the right 10 frames

Open the Project Library

Go to the Event Browser

Go to the Timeline

Open the Timeline Index

Zoom out of the Timeline, Event Browser, or Viewer
Zoom in to the Timeline, Event Browser, or Viewer

Move the playhead and skimmer to the beginning of the range
selection

Move the playhead and skimmer to the end of the range
selection

Zoom the contents to fit the size of the Event Browser, the
Viewer, or the Timeline

Toggle audio skimming

Go to the previous item (in the Event Browser) or the previous
edit point (in the Timeline)




Keyboard Shortcuts

Lesson Review

Down Arrow

m s 0 ©

-n

/ (slash)

r X &«

Spacebar

Go to the next item (in the Event Browser) or the next edit point
(in the Timeline)

Toggle video and audio skimming
Connect to primary storyline

Insert into primary or selected storyline
Append to primary or selected storyline
Rate selection as a Favorite

Play selection

Play reverse

Stop

Play forward

Set range start point

Set range end point

Play/pause
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Symbols and
Numbers
” (apostrophe) key, 229
- (minus) sign, 155, 210
, (comma) key, 154, 212
. (period) key, 154, 212
.caf extension
(Core Audio Format), 293
/ (slash), play selection, 93, 122, 178
; (semicolon) key, 229
+ (plus) sign, 155, 210
+3 dB fade option, 307
-3 dB fade option, 307

A

A key (Select tool), working with, 11
Action pop-up menu
optimizing Event Browser
for screening/marking
clips, 121
restoring default settings in
Event Browser, 95
sorting source clips
alphabetically, 168
sorting/viewing Events, 16-17
viewing/sorting Events, 20
Action safe zones
inserting title into primary
storyline, 332
modifying titles, 344-347
turning on/off, 348
Add (+) button, customizing
destinations, 492-493
Add Correction button, 459
Add Cross Dissolve, 241
Add Freeze Frame (Option-4),
preset speed, 395-396
Add Marker, 166
Add Rule pop-up menu, 106,
108-109, 140

532

Add to Audition, 182-186, 313
Additive color system, video as, 451
ADSR (attack, decay, sustain, and
release) steps, sound, 305
Alias files, 43-44
All category
Generators Browser, 356-357
Transitions Browser, 248-249
All Clips, Filter pop-up menu,
99-101
Alpha channels, 330
Analyze and Fix, imported clips,
52-53, 454
Analyzing process, imported clips,
51-58
Animation
adding bumper title, 352
adding credits, 352-355
adding title. see titles
applying Ken Burns effect,
413-417
Animation menu, reset clips to 0 dB
levels, 302, 304
Aperture, importing still images for
project from, 369
Apostrophe () key, 229
Append button, 127-128, 130-131
Append edit (E)
adding generator, 363
adding lower third to end as,
338
adding secondary storyline,
189-190
adding Slide bumper title, 349
adding title to end as, 330
insert edit vs., 142
remembering shortcut for, 172
in Timeline, 126-133
Apple devices, publishing project to,
481-485

Apple Pro Training Series: Final
Cut Pro X Advanced Editing
(Peachpit Press), 285, 418, 476

Apple ProRes codec,
transcoding to, 58

Applications, importing media
from other, 67

Applications folder, opening Final
Cut Pro, 6

Archive, backing up project and
Events, 504-507

Arrow tool, 11

Attack, decay, sustain, and release
(ADSR) steps, sound, 305

Attenuate audio, in Timeline, 286

Audible playback, disabling, 163

Audio. see also sound
connecting clips to primary

storyline, 150-155
customizing properties, 118
effects, 447-451

Audio, correcting problems
automatically enhancing, 318
comparing adjusted levels to

normalized waveforms,
321-322
overview of, 314-315
removing hum, 315-318
smoothing spike, 318-319

Audio Animation Editor, 450

Audio Enhancements
(Command-8), 316-317

Audio Enhancements pane, Audio
inspector, 316-318

Audio file, sharing Master file as,
480-481

Audio inspector, 298-302, 315-318

Audio meters
adjusting audio in Timeline,

286-287



adjusting audio peaks,
465-467
adjusting in Audio inspector,
299-303
color-coding system of,
281-282
Command-Shift-8 to display,
465
correcting problem audio, 315
increasing size of, 281
monitoring levels in Timeline,
280, 285
recording voiceovers using,
309
reflecting output dB of clip,
287
viewing peak levels in, 296
Audio skimming (Shift-S), 93,
121-123, 133, 145
Audio tab, Inspector, 148-150, 171
Audio transitions, 245, 273-275
Audition, duplicate as (Option-Y),
440
Audition clips
animating effects and,
439-447
comparing voiceover
recordings with, 313-314
keyboard shortcuts for,
186, 194
sampling music/sound
with, 314
setting up in project, 180-186
Audition Preview function, 184-185
Auto Enhance Audio, 318

B
B key (Blade tool), 204, 308-309
Background process, sharing as, 478
Background render, transitions,
242,252
Background Tasks indicator
(Command-9)
analyzing imported clips,
53-54
backing up projects/Events,
507
exporting image from project,
498-499
publishing project to video
sharing sites, 488

Backgrounds category, generators,
356-357
Backup, of projects and Events,
503-508
Balance checkbox, color, 453-454
Balance Color (Command-
Option-B), 454
Basic parameter, Text inspector, 344
Blade tool (B key), 204, 308-309
Bloom transition, 252
Blu-ray disc, exporting for, 499-503
Boost, adjusting audio in Timeline,
286
Brightness (or luminance levels)
for broadcast-safe video,
468-469
correcting video problems,
467-471
defined, 452
enhancing, 456-457
Broadcast-safe video, 468-471
B-roll clips
adding markers to, 162-167
connecting to primary
storyline, 168-175
inserting into primary
storyline, 139-144
inserting into Timeline,
137-138
lifting from primary storyline,
190-192
overwriting and replacing,
175-180
Bundle, of multiple destinations,
493-494

C

Camera
creating camera archive, 64
importing media from, 58-64
importing still images from,

369

metadata, 73

Category pane, Transitions Browser,
248

Change Duration (Control-D),
254-255, 270, 352

Change End Source Frame, Retime
Editor, 390, 421

Channel Configuration pane, Audio
inspector, 148-150, 315-318

Chapter markers
creating, 166

Index 533

including in Master file, 476
publishing project to Apple
devices, 483
Clear Selected Range (Option-X),
62,126, 141, 471
Clip Appearance button. see Clip
Height setting
Clip Browser, importing media
from camera, 61
Clip Duration slider, customizing
Event, 76
Clip Height setting
adding markers, 164
adjusting audio peaks, 466
enlarging clip thumbnails in
Timeline, 134, 144-145,
226
monitoring audio levels in
Timeline, 282-283
resizing Event Browser for
screening/marking, 121
resizing Event Browser to
show all clips, 24, 76, 139
Clip menu, Disable command, 163
Clip range
adding keywords to, 90-94
adding speed segment in,
388-389
adjusting volume in, 288-289
appending to Timeline, 128
creating range selection
(Command-drag), 125
creating range selection (Shift-
Command-I), 124
editing in Timeline, 120
importing camera media from
as, 62-63
keyboard shortcuts for, 93
marking as Favorite, 102, 123
rating, 95-103, 123
selecting, 97
Clip speed
altering for playback in
Retime Editor, 377-379
changes affecting placement of
other clips, 393
checking off as to-do item, 385
increasing, 381-384
overview of, 379-380
resetting, 384
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reversing direction, 380-381
slowing down, 383-384
trimming adjustments after
changing, 386
Close active window
(Command-W), 54
Closing
Final Cut Pro X, 34-35
Media Browser, 13
projects, 156
CNN iReports, publishing
project to, 485-489
Color
adding to bumpers, 352
adding to countdowns, 357
backgrounds, transitions,
263-265
mattes, 357-358
modifying parameters,
262-265
modifying title, 346
Color balance
for edited clips, 147-148
for imported clips, 52-53,
55-57
Color Board correction tool
correcting luminance, 467,
469-471
manually adjusting color,
454-459
Color enhancement
brightness or luminance
levels, 456-457
color balance, 452-454
manually, 454-458
methods for, 451
saturation level, 457-458
understanding color basics,
451-452
using Match Color function,
457-458
Color wheel (vector scope), 452
Color-coding
Audio meters, 281-283
keyboard shortcuts, 418
Colors window, 263-265, 346, 357
Columns, width of, 103
Comma (,) key, 154, 212
Command-, (comma)
see Preferences window
Command Editor
(Command-Option-K),
417-419

Command-[ (left bracket), return to
project, 209

Command-= (equals), zoom in
changing edited clips, 145
creating room in Timeline,

138
duplicating projects, 200
overwriting clips, 177
in Timeline, 31
trimming clips, 208
working with particular area,
147

Command-0. see Project Library
(Command-0)

Command-1 (Go to Event
Browser), 128

Command-2 (Go to Timeline), 128,
130, 142, 153

Command-4. see Inspector
(Command-4)

Command-5. see Effects Browser
(Command-5)

Command-6 (Show Color Board),
470

Command-7 (Show/Hide video
scopes), 455, 468

Command-8 (Audio
Enhancements), 316-317

Command-9. see Background Tasks
indicator (Command-9)

Command-A (select all clips),
43, 83, 291

Command-C. see copy
(Command-C)

Command-click (select group of
noncontiguous clips), using
throughout project, 61

Command-Control-Y (preview
audition clips), 185

Command-Delete (delete or move
to Trash), 88, 491

Command-drag (creating range
selection), 125

Command-E (Master File Share
window), 473, 495

Command-F (Filter window),
105-109, 140, 151

Command-G (Create Storyline),
187-188, 211, 271-272

Command-H (Hide Final Cut Pro),
34,59

Command-I. see Media Import
window (Command-I)
Command-K (Keyword Editor),
78-79, 81, 84-87, 94
Command-L (Loop Playback), 93
Command--(minus), zoom out, 32,
138, 200, 259
Command-Option-B (Balance
Color), 454
Command-Option-click (move
clip’s connection point), 171
Command-Option-K (Command
Editor), 417-419
Command-Option-Up Arrow (Lift
from Storyline), 191
Command-Q (Quit Final Cut Pro),
35
Command-R. see Retime Editor
(Command-R)
Command-Shift-1 (Show/Hide
Event Library), 195
Command-Shift-2 (Show/Hide
Timeline Index), 134, 137,
285, 376, 418
Command-Shift-8 (display Audio
meters), 465
Command-Shift-A (deselect clips),
61, 192, 206, 212-213
Command-Shift-K (new Keyword
Collection), 112
Command-Shift-Z (redo last
command), 214, 234
Command-T (apply default
transition), 242-245, 268-269,
308-309
Command-V (paste), 337
Command-W (close active
window), 54
Command-Y (create audition clips),
186
Command-Z (undo last command),
112, 173-174
Compatibility pop-up menu,
sharing project, 476, 482
Completed List, Timeline Index,
385
Compound clips
adding transitions to, 267-273
creating for sound effects,
296-297
grouping/nesting clips in
Timeline, 271
naming, 271-272



preserving placement of
voiceover clips, 211
understanding, 267
Compression pop-up menu, 488-
489, 493
Compressor, 496
Connect button, 153
Connect edit (Q), 150-155, 166—
175, 363
Connected clips
adding Overlap lower third as,
336-340
adding titles as, 335
applying transitions to,
267-273
editing bumpers as, 348
moving or deleting separately,
187
in Themes Browser, 364
Connection point, moving
(Command-Option-click), 171
Consolidate find people results,
imported clips, 52-53
Control-’ (apostrophe), move
playhead to next marker, 168,
195
Control-- (minus), lower clip
volumes 1 dB at a time, 291
Control-; (semicolon), move
playhead to previous marker,
168, 195
Control-= (equals), raise clip
volumes 1dB at a time, 288,
290, 291
Control-0 (remove all keywords
from all clips), 83
Control-D (Change Duration)
changing title clip, 352
for group of transitions, 270
for selected transition,
254-255
Control-E (Precision Editor), 226—
234, 243-244
Control-F (Favorites), 126-127,
130-131
Control-H (hide rejected), 100
Control-M (delete marker at current
playhead location), 195
Control-R (render selection), 252
Control-S (Expand Audio/Video),
230-231, 234
Control-Shift-I (play forward), 24

Control-V (Show/Hide Video
Animation Editor), 461
Control-Y (Show/Hide Skimmer
Info), 79, 84, 88-89
Copy (Command-C)
adding lower third, 337
applying audio effects, 449
copying effects between clips,
437
cropping image, 409-410
Copying files, 43, 436-439
Copyrights, music, 291
Core Audio Format (.caf extension),
293
Corner handles, transforming
image, 400-403
Countdown, creating with
generator, 357
Create New Event (Option-N), 41,
112
Create range selection (Shift-
Command-I), 124
Create Smart Collections after
analysis, 52-53
Create Storyline (Command-G),
187-188, 211, 271-272
Create Transition, 272
Crop button (Shift-C), 406, 411
Cropping images
Ken Burns effect, 413-417
overview of, 406, 411-413
Trim option, 407-411
Cross Dissolve transition
adding to other storylines, 268
applying, 241-245
as default transition, 239
locating in Timeline Index,
255-256
modifying duration, 253-254
re-applying as default, 273
Crossfades, audio
applying, 307-309
automatically added to video
transitions, 245, 273-275
defined, 308
parameters, 261
Customize command, keyboard
layout, 12
Customizing
audio/video properties for
project, 118
destinations menu, 489-496
keyboard layout, 12
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keyboard shortcuts, 417-419
marker name, 165
Cutaways

changing clip speed to extend,
380-381

connecting to primary
storyline using markers,
166-175

creating secondary storyline,
188-190

defined, 162

using markers to mark,
165-166

D

D key (overwrite edit), 177
Dashboard. see also Timecode
Audio meter, 280
Background Tasks indicator,
53-54
checking timecode of skimmer
location, 177
modifying transition duration,
254-255
not displayed for multiple
transitions, 270
viewing project in Timeline,
32
Dashcode, 129
Date, grouping clips by, 16-17
dB (decibels)
adjusting in Audio inspector,
300-302
for audio peaks, 466
changing volume on edited
clips, 145-146
connecting clips to primary
storyline, 152, 171
creating secondary storyline,
190
editing audio using, 286
monitoring levels in Timeline,
281-282
resetting clips to original 0 dB
levels, 302
setting levels, 283
Decay ADSR steps, in sounds, 305
Decibels (dB). see dB (decibels)
Default Event pop-up menu, new
project, 117
Delete
blank Event, 41



536 Index

destinations, 491-492
rejecting unwanted clip
portion, 100

removing clip selections/entire
clip, 202
removing keyframes, 319
removing titles, 341
using Command-Delete
(delete/move to Trash),
88, 491
Delicious Peace media, about, 18
Deselect clips (Command-Shift-A),
61, 192, 206, 212-213
Destinations
adding, 492
combining into bundle for
sharing, 493-495
deleting, 491-492
duplicating, 494
opening Preferences window,
490
positioning, 492-493
presets for sharing Master
file, 472
Record Audio options, 311
Dialogue. see sound
Disk
creating Event on hard, 41
grouping clips onto external,
17
Disk images, 499-504
Dock, opening Final Cut Pro
from, 6
Double-click, (open marker’s Edit
Marker dialog), 195
Down Arrow (move playhead
forward to next clip)
appending clips in Timeline,
131
connecting clips to primary
storyline, 153
trimming with, 213, 229
viewing projects in Timeline,
29
Dragging clips, to Timeline, 137
Drop Shadow effect, 459
Duplicate as Audition (Option-Y),
440
Duplicate Project
before applying transitions,
240
backing up project and
Events, 505

overview of, 199-200
saving version of project, 34
using Transitions Browser, 246
Duplicate Project and Referenced
Events, back up, 505
Duplicating project, 198-200
Duration
Change Duration command
(Control-D), 254-255,
270, 352
checking length of project
before trimming using,
201-202
default crossfade, 308
default transition, 240
media handles applying
transitions without
changing, 242-245
modifying audio crossfades,
274-275
modifying audio fade,
306-307
modifying clip speed, 381-382
modifying title clip, 352
modifying transitions, 253
255, 260-261, 269-270
replacing clips and, 179
role in choosing appropriate
clip, 183-184
trimming clips in storyline,
210
working with timecode in
generators, 359-362
Duration slider, 20, 22, 121
DVD, exporting for, 499-503

E
E key. see append edit (E)
Edge Treatment, 261-262
Edit points
covering with cutaways, 166
duplicating projects, 200
refining and trimming. see
trimming
Trim icon and, 210
using set markers as, 172
using Shift-? for quick look
at, 214
Edited clips, changing, 144-150
Editing process, taking notes in, 101
Effects
audio, 447-451

auditioning clips with, 183,
439-447
color enhancement, 451-459
copying between clips,
436-439
keyboard shortcuts for, 461
Media Browser displaying, 13
modifying parameters,
430-436
overview of, 423
summary review, 460-461
video, 424-430
Effects Browser (Command-5)
applying audio effects,
448-450
applying Broadcast Safe effect,
471
applying Drop Shadow effect,
459
applying video effects,
424-429
Effects icon, 13
Elements category, generators,
356-357
End (move playhead to end of
project), 37
End point (O key), 94
Enhancements pop-up menu, audio,
318
Equalization pop-up menu, hum
reduction, 318
Esc (Escape) key, 33, 333, 338
Event Browser
adding keywords to clips,
77-83
appending clips, 131
applying markers to source
clips, 166
basic functions, 7-8
Command-1 shortcut to, 128
controlling snapping, 132
creating freeze frames, 396
customizing Event using
metadata, 74-75
displayed when window is
active, 129
editing sound effect clips to
project, 294-297
grouping clips, 16-17
importing media into Event,
42-44
increasing size with pointer,
10



inserting clips into primary
storyline, 140-144
playing clip in, 37
resizing window, 76
restoring default settings in, 95
screening/marking clips in,
121-126
switching between Timeline
and, 128-129
viewing clips in, 19-26
Event Library
applying keywords to clip
range, 90-94
Command-Shift-1 to show/
hide, 234
creating new project, 117-119
customizing Event using
metadata, 72-77
Events stored in, 8
importing media into Event,
40-45
viewing and sorting Events,
14-17
widening to read Event names,
17
Events
arranging clips inside, 19-20
backing up, 503-508
changing display options
in, 44
color coded in Event Library,
74
Create New Event (Option-N),
41
deleting, 68
importing folders as Keyword
Collections, 46-51
importing media into, 40-45,
58-64, 66
overview of, 7-9
rule of thumb for, 40
viewing and sorting, 14-17
Events, organizing clips in
adding keywords, 77-83
applying keywords to clip
range, 90-94
assigning multiple keywords,
83-90
creating Smart Collections,
104-109
customizing using metadata,
72-77
keyboard shortcuts, 112

overview of, 71-72
rating, sorting, and searching,
95-104
summary review, 110-112
Expand Audio/Video (Control-S),
230-231, 234
Export pop-up menu, 498-499
Exporting, for Blu-Ray, DVD or
disk image, 499-503
Exports folder, 478
Extend function, trimming
timecode display, 360

F

F key. see Favorite (F)
Facebook, publishing project to,
485-489
Fade handles, 275, 306-307
Fade shapes, 307
Fades, audio, 305-309
Fairly Legal media, 45
Fast > 2x, changing clip speed,
381-382
Favorite (F)
changing label to descriptive
word, 103
Control-F to show Favorite
clips/ranges, 126-127,
130-131
inserting clips into primary
storyline, 141-142
marking clips/clip range as,
102-104, 123
marking selection in toolbar
as, 10
overlapping previously marked
Favorite, 124
rating range/selection as, 98
viewing clips tagged as, 98
Filmstrip view button
assigning multiple keywords
to clips, 84
creating Smart Collections,
104
customizing Event using
metadata, 73, 75
identifying clip range/editing
in Timeline, 120-126
importing media from
camera, 60
Filter pop-up menu
connecting clips to primary
storyline, 168
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rating, sorting, and searching
clips, 95-100
screening/marking clips in
Event Browser, 121
Filter window (Command-F),
105-109, 140, 151
Filtering, rated clips, 95
Final Cut Pro
Color Board, 454-459
hiding and closing, 34-35
metadata, 73
Projects folder, 119
Finalize Audition (Shift-Option-Y),
186, 314
Find people option, imported clips,
52-53, 55
Finder
backing up project and Events,
504
importing media from, 64-66
importing media from
camera, 59
viewing shared still image
file, 499
Find/replace function, changing text
in long credit roll, 354-355
Fine-tuning. see rough cut, fine-
tuning
Flash transition, adding to other
storylines, 268-269
Folders, importing as Keyword
Collections, 45-52
Formats, exporting still images,
497-499
Freeze frame effect, 395-396
Full Screen button, viewing project/
clip in, 33

G

Gain option, Record Audio, 311
Gap clips
inserting with Option-W
shortcut, 206
removing clip selections/
adding, 201-206
replacing with placeholders,
360-361
within storyline, 192
GarageBand source folder, Music
and Sound Browser, 292
Generator inspector, 357
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Generators
adding timecode, 359-361
creating color matte behind

credits, 358

creating countdown, 357
keyboard shortcuts, 371
overview of, 356-357
summary review, 370-371

Generators Browser, 356

Getting Started, installing software
and book files, 5

Ghost waveforms, 321

Go to Event Browser (Command-1),

128
Go to Timeline (Command-2), 128,
130, 142, 153

Group Events by Date, 17

Group Events by Disk, 17

Group of transitions, changing
duration, 269-270

H

H key (Hand tool), 227-228, 233

Hand tool (H key), 227-228, 233

Handles, media, 207, 209

Hard disk, backing up project and
Events to, 504

Hide Final Cut Pro (Command-H),
34,59

Hide rejected (Control-H), 100

Highlights control, Control Board,
470

Hold effect (Shift-H), 386-388

Home key (move playhead to start
of clip), 29, 130, 137-138, 142

Hue, defined, 451

Hum, removing in audio, 315-318

Hum Removal, Audio
Enhancements, 317-318

|
I key (set range start point), 93-94,
123, 141, 169, 215
I Think I Thought media, 359
Images
in background of transitions,
265-266
creating title theme with still,
364-368
cropping, 406-413
transforming, 396-406

Import Media button, Event
Browser, 42-43
Import Selected button, 61-63
Import tab, Preferences window,
65-66
Importing
analyzing/correcting imported
clips, 51-58
from camera, 58-64
from Finder, 64-66
fixing color balance on
imported clips, 454
folders, as keyword
collections, 45-51
keyboard shortcuts, 69
Media Import window. see
Media Import window
(Command-T)
media into an Event, 40-45
from other applications, 67-68
overview of, 39-40
still images in project, 369
summary review, 68-69
Input Device option, Record Audio,
311
Insert button, 142-143, 176
Insert edit (W)
adding generator to project,
363
connecting clips to primary
storyline, 172
inserting clips into primary
storyline, 144
inserting title into primary
storyline, 330
overwriting/replacing clips,
176
Inspector (Command-4). see also
Audio inspector
changing edited clips, 144,
147-150
connecting clips to primary
storyline, 171
enabling color balance in
Video tab, 56-57
modifying effect parameters,
430
modifying titles, 330-337, 340
modifying transition
parameters, 260-266
removing hum, 315-318
Institute of Radio Engineers (IRE),
broadcast-safe video, 468-469

Interface, Final Cut Pro X
about Delicious Peace media,
18
exploring, 7-9
following workflow, 4-5
hiding and closing, 34-35
keyboard shortcuts, 36-37
opening, 5-7
overview of, 3-4
resetting with Revert to
Original Layout, 10
skimming clips and changing
views, 19-26
summary review, 35-36
using menus, shortcuts, and
mouse, 9-14
viewing and sorting Events,
14-17
viewing projects in Timeline,
29-33
working in Project Library,
26-29
iPhoto, importing still images for
project, 369
IRE (Institute of Radio Engineers),
broadcast-safe video, 468-469
iTunes, 484
iTunes source folder, Music and
Sound Browser, 291

J

] key (play reverse), 24, 32

Jagged edge, at end of row of clips,
23

J-cuts (split edits), 306

K

K key (stop playback), 24, 32, 93

K tap J (move playhead one frame
to left), 36

K tap L (move playhead one frame
to right), 37

Kawomera (Delicious Peace)
Cooperative, 18

Ken Burns effect, 399, 413-417

Keyboard layout, customizing
keyboard shortcuts, 12

Keyboard shortcuts
building rough cut, 158-159
connect/insert/append edits,

172

customizing, 417-419



customizing keyboard layout
for, 12
effects, 461
fine-tuning rough cut,
233-234
finishing rough cut, 194-195
importing, 69
interface, 36-37
organizing clips in Event, 112
sharing project, 510
sound, 324-325
titles, generators and themes,
371
transitions, 276
trimming, 215
Keyframes, 288-290, 319-321, 466
Keyword Collections
adding keywords to clips/
creating, 77-83
assigning multiple keywords
to clips, 85-90
as color coded in Event
Library, 74
connecting clips to primary
storyline, 168-175
creating new with Command-
Shift-K, 112
creating Smart Collections
using, 107, 109
customizing Event using
metadata, 75-76
defined, 45
editing sound effect clips to
project, 294-297
importing folders as, 44-51
importing sound effects clips
as, 293
inserting clips into primary
storyline, 139-144
screening/marking clips using,
120-126
Keyword Editor (Command-K),
78-79, 81, 84-87, 94
Keyword shortcuts, 81, 87, 91-94
Keywords
applying single, to one or
more clips, 77-83
applying to clip range, 90-94
assigning multiple, to several
clips, 83-90
tagging to clips to create
metadata, 72-77

text field not searching
against, 99
KJ keys (play backward in slow
motion), 37
KL keys (play forward in slow
motion), 36

L

L key (play forward), 24, 32, 93, 122

L-cuts, 306

Left Arrow (move playhead to
previous frame), 30, 34, 93,
123

Left edge of edit point, 210

Lens flare transition, 251

Lesson Projects folder, revealing
contents of, 116

Letter X transition, 250, 256-258,
260-262

Lift from Storyline (Command-
Option-Up Arrow), 191

Lift item/section from Timeline/
leave gap (Shift-Delete), 194,
204

Linear fade option, 307

List, viewing clips as, 25

List View button
adding keywords to clip range,

90-94
adding keywords to clips, 78
audio clips in, 151-152
clips in, 25
customizing Event with
metadata, 73-77

source clips in, 168

Location pop-up menu, backing up
project and Events, 505

Loop Playback (Command-L), 93

Lower thirds, adding, 335-340

Luma, 467

Luma channels, 467, 469-470

Luminance levels. see brightness
(or luminance levels)

M
M key (set marker), 165-166, 203
Magnetic Timeline, 9, 133-138,
216, 383
Make Default, 268-269, 273
Markers
adding to project, 162-167
building rough cut, 119-126
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connecting cutaways to
primary storyline using,
166-175
defined, 165
deleting, 175
to-do, 376-377
editing clip range in Timeline,
124-126
keyboard shortcuts, 165-166,
168, 195, 203
open Edit Marker dialog with
double-click, 195
removing clip selections,
201-203
searching, 99-100
Master File Share window
(Command-E), 473, 495
Master file, sharing, 471-481
Match Color function, 457-458
Media Browser, 12-13
Media files. see importing
Media handles, 242-245
Media Import window
(Command-T)
analyzing/correcting imported
clips, 51-52
backing up project and Events,
504-505
creating camera archive in, 64
importing folders as Keyword
Collections, 46, 47, 49
importing from tape-based
device, 64
importing media from
camera, 58-63
importing media into Event,
42-44
working with themes, 364
Media Type rule, 106-107, 140
Menu bar, 11-13
Menus, working with, 9-14
Metadata
automatically logged during
import, 45
customizing Event using,
73-77
customizing in Master File
Share window, 473
embedding into shared files,
479
publishing project to video
sharing sites using, 486
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rejecting unwanted clip
portion, 100
searching for clip using, 103
understanding, 72-73
viewing in Favorites, 98-99
Microphone, recording voiceovers,
309
Minus (-) sign, 155, 210
Monitor option, Record Audio, 311
Monitoring audio, Roles metadata,
285
Motion properties, 375-379, 397-
398, 404
Mouse, 9-14, 138
Move playhead forward ten frames
(Shift-Right Arrow), 34
Move selections
left ten frames with
Shift-, (comma), 154
move left one frame with
comma (,), 154, 212
Multi-flip transition, 262, 263-266
Multi-Touch device, 13, 33
Music. see sound
Music and Sound Browser, 291-294

N

N key (toggle snapping), 121, 132,
254

Names, entering to search, 99

Naming conventions
compound clips, 271-272
duplicating projects, 200
Events, 41
Keyword Collections, 48
markers, 165
new project, 117
Smart Collections, 108

Narration, recording voiceovers,
309-314

New Compound Clip (Option-G),
271, 296-297

No Ranges or Keywords filter,
96-98

Normal parameter, Text inspector,
342

Notes, 99, 101-104, 361-362

(o)

O key (set range end point), 92-93,
97, 122-123, 141, 215

Opacity, 241-242, 404-406

Opacity slider, 404-406

Optical Flow, 391

Optimized media, 58

Option-\ (backslash), trimming edit
points, 215

Option key, 219, 223-224

Option-N (Create New Event), 41,
112

Option-[ (left bracket), trimming
edit points, 215, 234

Option-] (right bracket), trimming
edit points, 215, 234

Option-4 (Add Freeze Frame),
preset speed, 395-396

Option-click, 126, 150, 200,
257-258

Option-drag, 141, 402

Option-F (insert freeze frame), in
Timeline, 395

Option-G (New Compound Clip),
271, 296-297

Option-M (set marker/open Marker
window), 166

Option-S. see solo (Option-S)

Option-W (insert gap clip), 206

Option-X (Clear Selected Range),
62, 126, 141, 471

Option-Y (duplicate as Audition),
440

Ornate title, 330-335, 340-341

OS X Mountain Lion, opening Final
Cut Pro from, 6

Over the shoulder (OTS) shot, 141

Overlap transitions, 244-245, 272

Overwrite to Primary Storyline,
294-295

Overwriting clips, 176-177, 206

P

P key (Position tool), 205-206

Pan Mode pop-up menu, 302-303

Panning audio, 302

Parameters
modifying effect, 430-436
modifying transition, 260-266
Transform, 403-404

Paste (Command-V), 337

Paste Attributes (Shift-
Command-V), 409-411

Pause/play. see Spacebar (play/
pause)

Pauses, creating dramatic, 206

PC Connect mode, importing from
camera, 59
Peak indicators, Audio meters, 282
Percentage size, image
transformations, 400-402
Period (.) key, 154, 212
Persistent changes, transformations
as, 402
Photos Browser, importing still
images from, 369
Placeholders, 357, 360-361
Play backward in slow motion
(K)), 37
Play clip/project in reverse (Shift-
Spacebar), 37
Play forward (Control-Shift-I), 24
Play forward in slow motion (KL),
36
Play forward (L), 24, 32, 93, 122
Play reverse (]), 24, 32
Playback
alter clip speed for, 377-379
disable audible, 163
Loop Playback (Command-L),
93
play/pause. see Spacebar (play/
pause)
stop (K), 24, 32, 93
Playhead
defined, 22
delete marker at current
location of (Control-M),
195
move back one clip (Left
Arrow), 30, 34, 93, 123
move back ten frames (Shift-
Left Arrow), 34, 38, 190
move back to previous clip
(Up Arrow), 23, 34
move forward one frame
(Right Arrow), 34, 93,
123
move forward ten frames
(Shift-Right Arrow),
32,34
move forward to next clip
(Down Arrow), 29, 131,
153, 213, 229
move left one frame
(Ktap]), 36
move left ten frames with
Shift-, (comma), 213



move right one frame
[period (.)], 154, 212
move right one frame
(Ktap L), 37
move right ten frames
[Shift-period (.)], 154, 213
move to next marker
[Control-” (apostrophe)],
168, 195
move to previous marker
[Control-; (semicolon)],
168, 195
move to range end (Shift-O),
93, 141
move to range start (Shift-I),
93, 121-122, 141
position at end of project
(End), 37
position at head of project
(Home), 29, 130, 137
138, 142
snapping skimmer to, 22, 215
Play/pause. see Spacebar (play/
pause)
Plus (+) sign, 155, 210
Pointer, 9
Position tool (P), 205-206
Positioning, resized image clips,
400-402
Post-transcoding action (or post-
action) options, 483-485
Precision Editor (Control-E), 226-
234, 243-244
Preferences window
(Command-, [comma])
changing default duration for
freeze frames, 396
correcting problem audio, 321
creating audio fades, 308
customizing destinations,
490-491
importing media from Finder,
65
trimming clips in storyline,
213
using Trim tool, 218
Presets
color, 459
exporting with destination,
472
publishing project to Apple
devices, 482
speed effect, 392-396

Previewing
auditioned clips, 185
transitions in Transitions
Browser, 246, 248-249
Primary storyline
appended clip automatically
placed at end of, 189
appending clips to Timeline,
127-128, 130
changing edited clips in,
144-150
connecting clips to, 150-155
inserting clips into, 138-144
inserting generator into, 357
inserting lower third into, 338
inserting title into, 330
lifting B-roll clips from,
190-192
overwriting sound effect clip
to, 294-295
removing clip selections/
adding gaps in, 201-206
trimming clips in, 208-216
Project
backing up, 503-508
closing, 156
Command-[ shortcut for
returning to, 209
creating new, 116-119
Project Library (Command-0)
adding markers, 162-167
backing up project and Events,
503-508
creating new project, 116-119
duplicating projects in,
198-200
saving version of project in, 34
sharing project from, 471
sharing projects from, 489
showing/hiding, 9
working in, 26-29
Properties
customizing project audio/
video, 118
displaying for selected clip in
Inspector, 150
motion, 375-379, 397-398
publishing project to video
sharing sites, 486-489
Proxy media, creating, 58

Index 541

Q
Q key. see connect edit (Q)
QuickTime
publishing project to Apple
devices, 484-485
sharing Master file, 476,
478-479
QuickView, viewing shared still
image file, 499
Quit Final Cut Pro (Command-Q),
35

R

R key (Range Selection tool), 203,
388-389

Ramping sound levels, 305-309

Range. see clip range

Range end point (O key), 92-93, 97,
122-123, 141, 215

Range Selection tool (R key), 203,
388-389

Range start point (I key), 93-94,
123, 141, 169, 215

Rating buttons, 129

Rating clips
creating metadata by, 72
as Favorites, 124
overview of, 95-103

Record Audio window, voiceovers,
310-314

Recording voiceovers, 309-314

Redo last command (Command-
Shift-Z), 214, 234

Reference waveforms, 321-322

Reject (X) button, 100

Release, ADSR steps in sounds, 305

Remove (-) button, customizing
destinations, 491

Render selection (Control-R), 252

Replacing clips, 178-180

Reset (X) button, 95, 101, 109, 121

Reset parameter, animation menu,
302, 304

Reset Speed, 384

Resolution
customizing destinations, 493
publishing project to Apple

devices, 482
publishing project to video
sharing sites, 487-488

Resolution independent, editing

as, 40
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Retime Editor (Command-R)
hold effect, 387-388
increasing clip speed, 381-384
modifying clip playback,

377-379
preset speed effects, 391-396
reversing direction clip plays,
381-382

Retime pop-up menu, 381-382

Retiming clips
clip speed, 379-386
customizing keyboard

shortcuts, 417-419
holds and variable speed
segments, 386-391
motion properties and,
375-379
overview of, 375
preset speed effects, 391-396

Retiming handle, 384, 389-390

Return, creating additional line of
text, 333

Reverse Clip, retiming option, 380

Reverse Normal -100, 384

Revert to Original Layout, 10

Rewind > 2x preset, 394

Right Arrow (move playhead
forward one frame), 34, 93,
123

Right edge of edit point, 210

Ripple effect, 207, 210

Ripple trims, using Trim tool,
217-218

Roll trims, 220

Rotating image, 403

Rough cut, building
appending clips in Timeline,

126-133
changing edited clips, 144-150
closing project, 156
connecting clips to primary
storyline, 150-155
creating new project, 116-119
inserting clips into primary
storyline, 138-144
keyboard shortcuts, 158-159
overview of, 115-116
screening/marking clips,
119-126
summary review, 156-157
viewing/arranging clips in
Magnetic Timeline,
133-138

Rough cut, fine-tuning
applying Trim tool, 216-224
duplicating project, 198-200
keyboard shortcuts, 233-234
overview of, 197-198
removing clip selections/
adding gaps, 201-206
summary review, 232-233
trimming, 207-216
trimming with precision,
224-231
Rough cut, finishing
adding markers, 162-166
auditioning clips in project,
180-186
connecting clips to primary
storyline, 166-175
keyboard shortcuts for,
194-195
overview of, 161-162
overwriting and replacing
clips, 175-180
summary review, 193-194
working with storylines,
186-192
Rules, creating Smart Collections,
106, 108-109

S
S key. see skimming, on/off (S)
Saturation level, 452, 457-458
Saving
camera archives, 64
done automatically, 34
Scale percentages, transforming
image, 404
Scratch track, 309
Screening clips, 119-126
Scrolling credits, 352-355
S-curve fade option, 307
SDHC card, importing media from
cameras, 59-60
Searching clips
complex clips in Filter
window, 105
entering first letters to start,
256
find/replace title text, 354-355
in Music and Sound Browser,
292-294
rating by, 95-97

rating clip range as Favorite,
97-98
rejecting unwanted portion,
99-100
in Timeline Index. see
Timeline Index
via notes, 101-103
Secondary colors, defined, 451
Secondary storyline, 187-192,
267-273
Select all clips (Command-A), 43,
83,291
Select group of noncontiguous clips
(Command-click), 69
Select tool (A), 11
Semicolon (;), 229
Share button, activating, 472
Share icon, 479-480
Share inspector, 499
Sharing project
backing up projects/Events,
503-508
customizing destinations
menu, 489-496
exporting for Blu-ray, DVD, or
disk image, 499-503
exporting image from project,
496-499
keyboard shortcuts, 510
Master file. see Master file,
sharing
overview of, 463-464
preparing project, add visual
timecode, 471
preparing project, correct
audio peaks, 465-467
preparing project, correct
video, 467-471
publishing project to Apple
devices, 481-485
publishing project to video
sharing sites, 485-489
summary review, 508-509
Shift-. (period), clip moves right by
ten frames, 154, 213
Shift-? (play around skimmer),
213-214
Shift-, (comma), clip moves left by
ten frames, 154, 213
Shift-C (Crop button), 406, 411
Shift-click, 85



Shift-Command-8 (Show Audio
Meters), 280

Shift-Command-I (create range
selection), 124

Shift-Command-V (Paste
Attributes), 409-411

Shift-Delete (lift item/section from
Timeline and leave gap), 194,
204

Shift-drag (transforming image),
402-403

Shift-H (Hold), 386

Shift-I (move playhead to range
start), 93, 121-122, 141

Shift-Left Arrow (move playhead
back ten frames), 34, 38, 190

Shift-O (move playhead to range
end), 93, 141

Shift-Option-N (Show Clip Names),
19, 84

Shift-Option-Y (finalize audition),
186

Shift-Right Arrow (move playhead
forward ten frames), 32, 34

Shift-S (audio skimming), 93, 121-
123, 133, 145

Shift-Spacebar (play clip/project in
reverse), 37

Shift-T. see Transform (Shift-T)

Shift-Z. see zoom to fit (Shift-Z)

Shortcuts, 9-14

Show Audio Enhancements,
316-318

Show Audio Meters (Shift-
Command-8), 280

Show Clip Names (Shift-Option-N),
19, 84

Show Color Board (Command-6),
454, 470

Show Connections, adding markers,
164

Show Correction button, 459

Show incomplete to-do items
button, Timeline Index, 376

Show Skimmer Info (Control-Y),
79, 84

Show Standard Markers button, 167

Show Waveforms, 100

Show/Hide button, transforming
image, 404

Show/Hide Event Library
(Command-Shift-1), 8, 15, 195

Show/Hide Project Library button, 9

Show/Hide video scopes
(Command-7), 455, 468
Skimmer info (Control-Y), 79,
84, 89
Skimming
appending clips to Timeline,
132-133
in Clip Browser, 60
in Event Browser, 21- 26
marking clip range, 121-122
in Project Library, 28
selecting clip range, 96-98
snapping to clips, 132
as target location when
zooming Timeline, 200
timecode appearing in
Dashboard, 92
using location to extend edit
points, 216
Skimming, on/off (S), 37, 121-122,
133, 146
Slash (/) key, play selection, 93,
122,178
Slide bumper, 348-352
Slide mode, Trim tool, 223-224
Slip icon, Trim tool, 221-223
Slip mode, Trim tool, 221
Smart Collections
as color coded in Event
Library, 74
creating, 104-109
creating after analyzing
imported clips, 53-55
customizing Event using
metadata, 75
Snapping
adding markers with, 165
connecting audio clips to
primary storyline, 154
creating secondary storyline,
188
trimming small increments by
turning off, 212
turning on, 22
turning on for audio, 319
Solids category, generators, 356—
357, 359
Solo (Option-S)
adjusting audio in Timeline,
286-290
adjusting levels in Audio
inspector, 299-301, 304
creating audio fades, 306-307
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creating crossfades, 308
monitoring audio levels in
Timeline, 284-285
Sorting
Events, 14-17, 97-103
rated clips, 95
source clips alphabetically, 168
Sound
adding music and sound
effects, 291-297
adjusting in Timeline, 285-291
adjusting levels in Audio
inspector, 298-304
correcting problem audio.
see audio, correcting
problems
creating fades, 305-309
environment, 298
keyboard shortcuts, 324-325
monitoring in Timeline,
280-285
overview of, 279-280
recording voiceovers, 309-314
setting decibel levels, 283
summary review, 323-324
Spacebar (play/pause)
appending clips to Timeline,
131
defined, 37, 159
marking clip range, 121-122
stopping preview of
auditioned clips, 185
Speakers
lowering volume for sound
effects, 293
recording voiceovers, 309
in your environment, 298
Speed. see clip speed; retiming clips
Speed Ramp preset, 392-393
Split edits (J-cuts), 306
Stereo Left/Right, Pan Amount
slider, 303
Still images
applying Ken Burns effect to,
399, 413-417
creating Smart Collections of,
107-109
exporting from project,
496-499
thumbnails of video clips vs.,
365
using in project, 369
working with themes, 364-369
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Storyline
adding transitions to other,
267-273
create (Command-G),
187-188, 271-272
primary. see primary storyline
working with, 186-192
Storyline shelf, 188-190, 211-212
Style pop-up menu, Text inspector,
342-343
Sustain, ADSR steps in sounds, 305
Sweetening, audio, 291
System Preferences, 298

T
T key. see Trim tool (T)
Tag options, Timeline Index, 376
Text
changing title, 333
creating Smart Collections of,
105-107
editing for still image or
graphic, 365-369
searching for clips by, 99
typing title in Viewer, 333
Text field, Text inspector, 343
Text inspector
adding bumper title, 350-351
choosing stylized fonts in,
342-344
modifying font and color for
credits, 354
modifying title color, 346-347
Textures category, generators,
356-357
Themes
adding to titles, 363-369
keyboard shortcuts, 371
summary review, 370-371
templates for Blu-ray output,
502
Themes Browser, 363-369
Timecode
checking skimmer location in
clip, 177
Dashboard and, 23-24
in Dashboard when skimming
clips, 92
defined, 24
displayed when Timeline
window is active, 129

displaying marker location,
166

modifying transition duration,
254-255

preparing for project output
with visual, 471

working with generators,

359-360
Timeline
accessing tools to edit project
in, 10-11

adjusting view in, 144-145
appending clips in, 126-133
basic functions of, 7, 9
Command-2 shortcut to, 153
controlling snapping in, 132
creating room for new
material in, 137-138
display when window is active,
129
displaying stacked clips in, 170
identifying clip range/editing
in, 120-126
inserting clips into primary
storyline, 143-144
new project opening
automatically in, 118
playing clip in, 37
switching between Event
Browser and, 128
viewing projects in, 29-33
viewing voiceover recording
in, 312
Timeline, adjusting audio in
within clip range using
keyframes, 288-290
for entire project, 291
overview of, 285
using menu command or
keyboard shortcut for,
288
using Solo function, 286-290
Timeline, monitoring audio in
disabling clips from audio
mix, 283-284
with Roles metadata, 285
using Audio meters to track
levels, 280-283
using Solo function, 284-285
Timeline history arrow, 240
Timeline Index
changing clip speed in,
380-385

closing to allow room for
project clips, 187
connecting clips to primary
storyline, 167, 172
deleting transitions from, 260
exporting image from project,
497
locating title clips to change
in, 341-342
searching for transitions in,
255-256, 258, 260
show/hide with Command-
Shift-2, 134, 137, 285,
376, 418
to-do markers in, 376-377,
385
viewing/arranging clips in
Magnetic Timeline,
134-137
viewing/navigating markers,
167
Title inspector
adding bumper title, 350-352
adding imported stills to
project, 365-367
changing fonts in, 344-346
Title safe zones
adding lower third, 338-339
inserting title into primary
storyline, 332
modifying titles, 344-347
turning on/off, 348
Titles
adding bumpers, 347-352
adding credits, 352-355
adding lower third, 335-340
adding themes to, 363-369
changing font and color of
text, 344-347
determining name of font
used, 340-341
keyboard shortcuts, 371
locating title clip for font
change, 341-342
overview of, 340
stylized font options, 342-344
summary review, 370-371
using alpha channels
for transparent
backgrounds, 330
using Titles Browser, 328-335
Titles Browser
action safe zones, 332



adding bumpers, 347-352
adding credits, 352-355
adding lower third, 336
applying title, 334-335
categories and subcategories,
329
inserting title into primary
storyline, 330
overview of, 328-329
repositioning title in Viewer,
334
selecting Build In/Out
category, 330
typing in text in Viewer, 333
Toolbar, resizing windows in, 10
Tools pop-up menu, 10-11
Transcoding media files, 58
Transform (Shift-T), 400-401,
407-409
Crop controls vs., 407
cropping images, 409-411
transforming images, 399-403
Transforming clips
cropping image, 406413
customizing keyboard
shortcuts, 417-419
Ken Burns effect, 413-417
transforming image, 396-406
Transforming images
display Scale percentages, 404
motion properties of finished
project, 397-398
opacity, 404-406
overview of, 396-397
Transform controls in Viewer,
399-403
Transform parameters,
403-404
using Shift-drag, 402-403
Transition inspector, Audio
Crossfade controls, 309
Transitions
adding to other storylines/
compound clips,
267-273
applying video, 241-246
audio transitions, 273-275
changing parameters in
Inspector, 260-266
Command-T shortcut for
default, 242-245, 268-
269, 308-309
cross dissolves as default, 239

default duration for, 240
deleting from Timeline, 260
keyboard shortcuts, 276
modifying durations, 253-256
modifying Letter X transition,
256-258
modifying Video Wall
transition, 258-260
overview of, 237-238
preparing for, 238-240
previewing frame by frame,
258
summary review, 276-277
theme, 363
using Transitions Browser. see
Transitions Browser
Transitions Browser
applying Flash transition,
268-269
applying Lens Flare, 251
applying Letter X, 250
applying Multi-flip transition,
262-263
applying Video Wall, 251-252
dragging transition to
Timeline edit from, 250
opening, 247-248
overview of, 246
previewing transitions,
248-249
replacing one transition with
another, 252
Transparency, adjusting image
opacity, 404-406
Transport controls, Viewer, 31
Trim icon, 210
Trim info flag, 210
Trim option, Crop control, 407-409
Trim targets, 215
Trim tool (T)
adjusting audio/video
separately, 231
enabling detailed trimming
feedback, 219
features of, 216-217
ripple mode, 217-218
roll mode, 220
showing both clips in edit
point, 218
slide mode, 223-224
slip mode, 221-223
using Left/Right Arrow keys
with edit points in, 231
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Trimming
after changing clip speed, 386
applying Trim tool. see Trim
tool (T)
keyboard shortcuts, 215
small increments, 212
understanding, 207-216
Trimming with precision
adjusting audio/video
separately, 230-231
incoming clip, 228-229
opening Precision Editor,
226-227
opening project, 225-226
outgoing clip, 227-228
overview of, 224-225
roll trims, 229-230
using Hand tool, 227-228
Typeface options, Title inspector,
344

U

Undo last command (Command-Z),
112, 173-174

Up, modifying volume, 288

Up Arrow (move playhead back to
previous clip), 23, 34

Use Image Well, 265-266

User metadata, 73

\'J
V key (Disable/Enable)
audio playback, 163
clips from audio mix, 283-284
editing sound effect clips to
project, 297
Variable speed segments, and holds,
386-391
Vector scope (color wheel), 452
Video
customizing properties for,
118
effects, 424-430
generators. see generators
Video Animation Editor
(Control-V), 430, 433-436,
439, 447, 461
Video inspector
adjusting image opacity,
404-406
changing edited clips, 147-148
color balancing, 453-454
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effects to transform titles in,
347
enabling color balance, 56-57
transform motion parameters,
404
transforming image, 403
Video scopes, 455, 468-470
Video sharing sites, publishing
project to, 485-489
Video skimming (Shift-S), 132
Video transitions, 241-246
Video Wall transition, 251-252,
258-259
View menu, skimming clips in, 21
View Notes, Generator inspector,
361-362
Viewer
adding lower third title in,
334-337
basic function of, 7
decreasing size of, 10
display when Event Browser
window is active, 129
display when Timeline
window is active, 129
displaying clip in, 21
displaying stacked clips in, 170
editing text for still image or
graphic, 367-369
repositioning title in, 334
syncing sound effects with
video action, 296
Transform controls in, 399
turning title/action safe zones
off and on, 348
typing title in, 333
video scopes open in, 455
viewing projects in Timeline,
30
Viewer, Media Import, 43
Viewing
clips in Magnetic Timeline,
133-138
Events, 14-17

Vimeo, publishing project to,
485-489
Visual indicators, trimming clips,
215-216
Voiceovers
adjusting audio level, 299-301
preserving current placement,
211
recording, 309-314
trimming storyline clips to
match, 208, 210-212
Volume
adjusting in Audio inspector,
298-304
adjusting in Timeline,
285-291
adjusting when recording
voiceovers, 309
changing on edited clips,
144-150
lowering one dB at a time, 291
monitoring audio levels in
Timeline, 280-285
raising one dB at a time, 288,
290-291, 309
Volume and Pan control panel,
Audio inspector, 300-303
Volume slider, Inspector
adjusting levels in Audio
inspector, 300-302
changing edited clips, 150
connecting clips to primary
storyline, 171
creating secondary storyline,
189-190
Volume System Status icon, 298

w
W key. see insert edit (W)
Wally trophy, 130
Waveform Monitor, enhancing
color, 456
Waveforms
adjusting audio peaks,
466-467

changing edited clips, 145
connecting audio clips to
primary storyline,
152-155
correcting luminance in video,
468-470
creating audio fades, 307
reference, 321-322
removing hum, 316
viewing ADSR steps in shapes
of, 305
Weighted search, 105
White-balance, color basics, 451
Window menu, 11-13
Workflows, following, 4-5

X

X (reject button), 100

Y

YouTube, publishing project to,
485-489

Y4

Zero to Hero media, 119

Zoom
in. see Command-= (equals),
zoom in
out. see Command--(minus),
zoom out
Zoom tool (Z key) in toolbar,
200, 233

Zoom to fit (Shift-Z)

creating Smart Collections,
104

duplicating projects, 200

out of view clips after opening
Timeline Index, 135-136

trimming clips, 208

viewing all clips in Timeline,
131, 151
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